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Designing Embedded TCP/IP ﬁ

Monitor and Control
Lab Background/Flow, Solutions & Symbols:

( Exercise Background and Flow: \

m Many embedded applications can be functionally enhanced if the designer includes the ability to
access the system via the existing internet infrastructure. This concept was the focus of a webi-
nar series, available on www.microchip.com/ethernet, that discusses adding Ethernet networking
capability to a soda vending machine. That webinar series was the basis for developing this class
and the 6 associated labs.

The user can choose one of 3 MCU platforms: 1) PIC18F, 2)PIC24F or 3)PIC32MX. Three MAC/
PHY options are also available in the class. The PIC18F, via the PICDEM.net 2 board offers an
integrated MAC/PHY or an external ENC28J60. The latter two offer one of three MAC/PHYs:
ENC28J60 10Mbps, ENC624J600 10/100 Mbps, or MRF24WBO0 wireless 1-2Mbps all via the
Ethernet PICTail Plus modules This choice is facilitated in the source files via #if defines shown in
HardwareProfile.h header file.

Lab1-Join the Network-starts by using a demo application from the Microchip TCPIP stack distribu-
tion then utilizes the TCPIPConfig utility to set the development board up for the balance of the
labs. Completion of this lab is required as the board’s assigned MAC address and user-specified
board name is copied to the subsequent labs files via the Replicate HWConfig.bat routine via the
TCPIPConfig.hfile.

Lab 2 is an exercise in designing an business card image on a HTML/CSS web page. Since this is
a practice exercise the files are erased during subsequent labs. However, the user is given modifi-
able vending machine web pages to use for Labs 3 thru 6. These labs steer the user thru the proc-
ess of integrating the vending machine application code with the TCP/IP stack, removing blocking
code for maximum performance, and customizing for monitoring and controlling remote apps.

All the files used in these exercises have been loaded into the C\RTC\COM4201\ directories along
with the most recent version of the Microchip released TCP/IP stack. When newer stacks are web-
downloaded, they are stored in a C:\Microchip Solutions folder during normal install. The applica-

\ tions used in this class are available in the most recent stack versions.
-
m Solutions:
All but Lab 1 have solution projects available in their respective Lab 3: Step 8

folders. However, for some labs just compiling the MCU solution
is not adequate to complete the exercise. When using a solution
workspace and it's associated completed firmware entries refer to Lab 5: Step 14
the enclosed table for a starting point to complete the exercise. Lab 6: Step 3

Lab 4: Step 6
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@ Code Analysis-HardwareProfile.h

Each compiler, facilitated by the HardwareProfile.h file and partially shown below, can determine the Microchip develop-
ment platform used based on the compiler and part selected within the MPLAB project. Unique versions of this file are
needed to differentiate between the MAC/PHY choices in the class. This is handled by TCPIP HWConfig.bat in Lab 1.

-
HardwareProfile.h

// Choose which hardware profile to compile for here. See
// the hardware profiles below for meaning of various options.
//#define PICDEMNET2

//#define HPC_EXPLORER

//#define PICDEMZ

//#define PIC24FJ64GA004_PIM // Explorer 16, but with the PIC24FJ64GA004
//#define EXPLORER_16 // PIC24FJ128GA010, PIC24HJ256GP610,
//#define DSPICDEMI1

//#define DSPICDEMNET1 // Not currently supported, wrong Ethernet
//#define DSPICDEMNET2 // Not currently supported, wrong Ethernet

//#define YOUR_BOARD

// If no hardware profiles are defined, assume that we are using

// a Microchip demo board and try to auto-select the correct profile

// based on processor selected in MPLAB

#1if !defined (PICDEMNET2) && !defined(HPC_EXPLORER) && !defined(PICDEMZ) &&

#if defined(__18F97J60) || defined(_18F97J60)
#define PICDEMNET2
#elif defined(___18F67J60) || defined(_18F67J60)
#define INTERNET_RADIO
#elif defined(___18F8722) || defined(__18F87J10) || defined(_18F8722)
#define HPC_EXPLORER
.
m Symbols
m Helpful information for completing the lab2 g BACKGROUND and PURPOSE of the Lab
PC configuration for the lab. m a Procedural Commands to be executed
@ Sections of Ansi-C code E Sections of HTML/CSS code

. Target results of the lab Code Analysis and Conclusions of the lab

Cautions or warnings about frequent mistakes

(3 E:
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Lab Exercise 1

Join the Network

g Purpose

Before a device can be connected to a network, it needs a unique host name and MAC address. This ensures that the device
can communicate independently with other network nodes, and prevents duplicate addresses on the network.

In this first lab, the TCPIPConfig Wizard will be used to configure a unique address for your development hardware.
These changes will be written to a configuration file named TCPIPConfig.h that is included in the project file, and will
be compiled into the COM4201 WiFi Demo App project. To finish the lab, you will upload a set of example web pages
and test the network connection.

Requirements

Software: TCPIPConfig Wizard from 1538 Lab Build Installer v1.536

Environment: MPLAB® IDE 8.60 or later or X, 1538 Lab Build Installer 1.536

C Compiler: MPLAB C18 v3.38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ | MPLAB ICD3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Lab1...

Objectives

® Configure the lab class hardware platform and ensure it is connected to the local LAN.
® Use the TCPIP Config Utility to make specify the hardware configuration.

m Procedures

File » Close Workspace

o If you have a previous MPLAB project open, you must first close it by selecting from the menu:

Confirm the following directory/folder is used during the utility processing:

r Project Directory:
d C:\Masters\1538\Lab1\*




Launch the TCPIP Config Wizard to modify the TCPIPConfig.h.

Start » Programs » Microchip » 1538 » TCPIPConfig Wizard

Browse to ENSURE the Lab1\Configs directory shown below. Check the CONFIGURE WIRELESS SET-
TINGS if using the WiFi module. Confirm that Show Advanced Settings is not checked. Select NEXT.

Network Configuration

# Microchip TCP/IP Configuration Wizard

B -

i i Microchip TCP/IP Configuration Wizard

This tool will help you configure the TCPR/IP Stack by modifying the
TCPIPConfig.h and WF_Config.h configuration files based on your
answers to the following questions. Advanced users may wish to
{ configure these files manually.
-+ Select the copy of TCPIPConfig h to modify (basic stack corfiguration):
B V] [C\MTT\COM4207\Lab1\Configs'your mac-phy type b | [ Browse.. |

Select the copy of WF_Config.h to modify (wireless configuration):

[ [c\MTT\COM4201\Lab 1"WF_Config h |

7] Show Advanced Settings

@' M tRQCHj‘;:

Ty Try Try Ty Tty Version 1.0.4168.28618

Build Date May 31. 2011

Module Selection

¥k F 1| H
# Micrachip TCP/IP Configuration

Module Selection
what sort of application are you building?

Select the basic components you need for your application. You will be able to
select more specific options on the following pages.

Application Protocols Security Protocols Custom Protocols
[¥] Web Server [T] SS5L Server [T Custom Protocol over TCP

| E-mail Client [T SSL Cliert | Custom Protocol ower UDP
elnet Server [ Berkeley (BSD) Sockets AP

|| SNMP Agert {Server) BSD Socket Count

5

[E] TFTP Client

'0 Poirt to @ module for more information...
|
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Example Modules

A £ Microchip TCP/IP Configuration Wizan

Module Selection
Wwhat example modules would you like to include?

Select the example modules you would like included for this build. These modules
demonstrate the use of the TCP/IP stack for various custom applications.

| Generic TCP Client Example
| Generc TCP Server Example

Serial to Ethemet Bridge

—| TCP Perfformance Test

| UDP Performance Test

6 Point to a module for more information....
[ )

Define and enter a unique host name for your board on the NETWORK CONFIGURATION screen
shown below. The name must be 15 characters or less, and cannot contain \/: * ? " ; |

Network Configuration

% Microchip TCP/IP Configuration Wizard

MNetwork Configuration

Host Name
TOUR-HOST-MAME

Default MAC Address
oo - Oa A3 |- 00 oo | - | xed

Six hexadecimal bytes. The first three are the OUI
assigned by the IEEE. Microchip development boards
o AC an OUl of 00:04:-A3,

byt ated fin decimal) on a

ickcer on the reverse side of each. The ENCXZ2AJ600.

MRFZ4WBD will use the hardwars preprogrammed MAC
address if the walue 00-04-42-00-00-00 o

Microchip assigned Ethernet MAC address decimal numbers are labeled on the wired

m 10Mbps PICTail Plus module or on the back of the PICDEM.net 2 development board.
When using either of these, step 5 will require you to convert the Ethernet decimal number
to a hex MAC address using the Windows calculator, left pad with zeros. If the number is
not present, select a unique 6 digit hex number and continue.Eg.12345 = 00:30:39 hex.
10/100Mbps PICTail and MRF24WBO0 have preprogrammed MAC addresses, so click
NEXT thru step 5.

corresponding to the Ethernet serial decimal number printed on the label. If using the 10/100 PICtail Plus or

e If using PICDEM.net 2 or 10Mbps PicTail plus module, Enter the last 3 bytes of the MAC address field, in hex
the ZG2100, ensure that the last 3 hexadecimal digits are 00-00-00.

For wired configurations with the ENC28J60 or ENCx24J600

Click Next thru the following screens, and click Finish to complete the session.
Skip to STEP 6 to continue the configuration process.

1-3



... 1538TCP2
For wireless configurations using MRF24WBO0 PICtail Plus Module:

Check the appropriate boxes for the regional configurations in the 2 screens below:

Click Next thru the following screens (no Security, no Web page change, no MPFS image change), until
Click Finish to complete the utility session.

Continue to Step 6 to continue the configuration process.

Network Configuration

;—" Microchip TCP/IP Configuration Wizard

Wireless Configuration
Which wireless options will you need?

Default SSID Mame — Scan Settings —

|Microchip Demo AP ¥ Use Scan Functions

Default Metwork Type Default Scan Type Ritry Court

| Infrastructure = | Active Scan = [ =

Default PS Poll Scan Channels

= Mics 1 lieh 4 Llichy I icn 10 I ics 13
[ ien2 ioans Tlang Mooanil Ich 14

| Disabled

INoh3a Wohe " one I choi2

y Point to @ module for mare information ...

Network Configuration

-+ Microchip TCP/IP Configuration Wizard

Wireless Configuration
Which wireless options will you need?

General Options
I+ Use TX Power Control Functions M Use Power Save Functions M Use Multicast Functions
I+ Use Individual Sets/Gets ¥ Use Group Sets/Gets ™ Use Gratuitous ARP
1 Debug Mode
Ewvent Motifications
v Connection Attempt Successful ¥ Connection Attempt Failed v Connection Temporarby Lost

I+ Connection Pemanenthy Lost ¥ Connection Reestablished

y Paint to a module for more information ...

Cancel




1538-TCP2

Execute the batch script to copy TCPIP configuration just completed to all of the lab and lab solution pro-
ject folders for use later in the class.

Start » Programs » Microchip » 1538 » Replicate TCPIPCONFIG-HeaderFile.bat

[ C:\Masters\1538\Lab1\Lab1-C**-***-*** ]

P!
MPLAB File » Open Project =

Labl-C18-PICDN2-ETH97 . Xfor the PICDEM.net 2 with internal MAC/PHY setup
Labl-C18-PICDN2-MRF24W.X for the PICDEM.net 2 with Wireless MAC/PHY setup
Labl-C30-EXP16-ENC28.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Labl-C30-EXP16-ENC624.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Labl-C30-EXP16-MRF24WB.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Labl-C32-EXP16-ENC28.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Labl-C32-EXP16-ENC624.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Labl-C32-EXP16-MRF24WB.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

[ i SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

D@ BUILD TO CONFIRM NO SYNTAX ERRORS

—llﬁ‘—ll —ll SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

X
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m About Network Settings

The demo application stores network configuration settings in EEPROM, so settings stored in the project file are only
loaded when EEPROM data is not present. Procedure #11 is only required when new network settings are configured
for the project. THIS ONLY NEEDS TO BE COMPLETED AFTER PROGRAMMING IN LABI.

° Confirm a new IP address from the Router appears on the LCD, something besides 169.254...
Clear the on-board EEPROM by:

1. Hold the right-most pushbutton down (S5 on PICDEM.net 2, S4 on Explorer 16)
2. Press and release the /MCLR button (S1 on PICDEM.net 2, S1 on Explorer 16)
3. Continue holding the right-most button until several LEDs blink once.

4. Release the right-most button

[ C:\Masters\1538\Lab1\MPFSImg2.bin

http://UNIQUE-NAME/mpfsupload into the address bar. Use the host name defined in Step 4.
Upload the MPFSImg2 .bin bundle of web pages to the target system when prompted.

Click the link for Site Main Page. Navigate the demo website specifically in the upper right corner where you
should be able to confirm the switch, potentiometer and LED operations.

@ Open a web browser and access the webpage upload function by entering

1-6
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@ N
m Helpful Suggestions for unfound hostname

In some PC configurations, Firewall settings can block browsers from properly connected via the hostname specifica-
tion used in Step 12 and follow-on labs. If this is experienced, it is recommended to disable the PC firewall software
for completion of the lab exercises.

Also, multiple unsuccessful attempts to access the development boards by hostname can cause an unusable browser
cache configuration. It is helpful to try one of the following two procedures prior to repeating the rebuild/reprogram
sequence:

- Execute nbtstat —R in a DOS CMD window to purge the browser cache OR - Use the new IP
address that was assigned by the router in-lieu of the hostname in steps above

Sample Web Page Display

z
n
|
0
n
I
T

TCP/IP Stack Demo Application

WelcomE! {<lick to toggle)

Dynamic Variables -

Stack Version: v5.25

Form Processing - Buttons:
Build Date: J 18 2010 12:21:24

ui ate un W R T
Authentication _
This site demonstrates the power, flexibility, Potentiometer: 554
Cookies and =scalability of an 8, 16, or 32-bit embedded
web server. Everything vou see is powered by
a Microchip PIC microcontroller running the Microchip TCR/IP Stack.

File Uploads

On the right vou'll =ee the current status of the demo board. For a quick example,
click the LED= to toggle the lights on the board. Press the push buttons (except
MCLR!) or turn the potentiometer and you'll see the status update immediately.

e This examples uses AJ1AX technigues to provide real-time feedback.

Metwork

e T This =ite is provided as a tutorial for the wvaricus features of the HTTP web server,

including:

SNMP _ _ . - 2 :
Configuration Dynamic Variable Substltl_.ltlon - display rgal—tlme data
Form Processing - handle input from the client
Authentication - require a user name and password

Cookies - store session state information for richer applications
File Uploads - parse files for configuration settings and more

Several example applications are also provided for updating configuration
narameters. sendinn e-mails. and controllinn the Mvnamic MNS client. Thanks tn

m Additional Features shown in this web page

This sample web page demonstrates many of the capabilities of the Microchip TCP/IP Stack. If you finish early, you
can try out the various features. The LEDs on the board can be controlled via the status box at the upper right. (If
you’ve selected the Explorer 16, the left-most LED shares a pin with a pushbutton, and so it will not display correctly
and be uncontrollable.) The board reports back the status of its pushbuttons and potentiometer after they are changed
on the target system.
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Results

You have just set up the TCPIP Demo App project on your development board and uploaded a sample set of web pages.
When complete, you should see a page similar to the screen shown on the previous page: SAMPLE WEB PAGE DIS-
PLAY.

Code Analysis

The TCP/IP Config Wizard utility was used to modify network software configuration settings via compiler macros
(#define )stored in TCPIPConfig.h. This utility changes the header file in your project via designer input
but also can be viewed and edited via a text editor. Open TCPIPConfig.h and find where the tool stored the updated
host name and MAC address. You’ll see many other settings as well, most of which can be configured by enabling ad-
vanced settings in the utility. Specific board configurations, as discussed earlier, are handled similarly in the Hardware-
Profile.h file.

&8 TCPIPConfig.h |
d.
5. - - !!!ee— — b - ---——————————————
142
XY /' * Defanlt Hetwork Configuration
1494 These settings are only used i1if data i=s not found in EEPROM.
145 To clear EEPRCM, hold BUITCOHO, reset the board, and continue
146 holding until the LEDs flash. Release, and reset again.
147 B
s fdefine MY DEFAULT HOST HAME "HMCHPECOARD™
149
sl fdefine MY DEFAULT MAC EYTEL (O=00)
skl fdefine MY DEFAULT MAC EYTEZ (O=04)
sl fdefine MY DEFAULT MAC EYTES [(O=RAS)
skl fdefine MY DEFAULT MAC EYTES (O=00)
M WP fdefine MY DEFAULT MAC EYTES (DO=4C)

sl fdefine MY DEFAULT MAC EYTEES (O=RT)
156

-l fdefine MY DEFAULT IF ADDRE BYTEL (1le9ul)
iRl ¥define MY DEFAULT IF ADDE EYTEZ (2549ual)
il fdefine MY DEFAULT IF ADDR EBYTES (dlual)
iRl fdefine MY DEFAULT IF ADDR EYTE4 (dlual)
16l

#define MY DEFAULT MASK BYTEL (255ual)

B a_ o Wi TOmTOEmTTT T AW T s s RN ‘

\_
:()3 Conclusions

This lab has confirmed that your network setup and development board are operational. You have assigned a unique MAC
address to your board, as well as a host name that can be accessed independently of the board’s IP address. This host name
operates through the NetBIOS Name Service, which is limited to the local subnet (in this case, your and your next door
neighbor). Host name access outside of subnets is accomplished through DNS, which will be discussed later.

The IP address shown on the LCD screen has been automatically assigned by a DHCP server in a local router. DHCP is
standard for most networks, and has replaced the need to hard code a static IP address. Static IP addresses can be config-
ured when necessary.
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Lab Exercise 2

Using Wireshark for Protocol Debugging

2 Purpose

To obtain a working knowledge of using the Wireshark
protocol sniffing software using the HTTP Get Message
implementation from Lab 1 of this class.

Requirements

Software: Wireshark utility from 1538 Lab Build Installer v1.536

Environment: MPLAB® IDE 8.60 , X or later, 1538 Masters Install Script 1.536

C Compiler: MPLAB C18 v3..38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net " 2, OR
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10 Mbps, 10/100 Mbps PICtail Plus or MRF24WB0O OR
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10 Mbps, 10/100 Mbps PICtail Plus or MRF24WBO0
AND MPLAB REAL ICE™ In-Circuit Emulator, or MPLAB ICD 3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Lab2...

Objectives

e Utilize Wireshark to test and debug communication traffic between Host and Client.
® Understand some TCPIP parameters such as: BOOTP, Payload content analysis, et. al.

[ Web Page Directory: C:\Master\1538\Lab2\* ]

i-1



1538 TCP2

m Procedures

Confirm Lab 1 was complete, including executing the Replicate TCPIPCONFIG-HeaderFile.bat confirmi
Ing your unique hardware. If you have a previous MPLAB IDE project open, you must first close it by selecting
from the menu: File » Close Workspace

The MPFS2 Utility generates the file HTTPPrint . h. This must be completed prior to compiling your MPLAB
IDE project to include the dynamic variable callback functions already included in customHTTPapp.c.

Start » Programs » Microchip » 1538 » MPFS2

Confirm your 1538\Lab2\WebPages 2 folder and unique hostname is listed as the Device Address within the Up-
load Settings section. Click Generate and Upload to program your new pages to the development board. Con-
firm the utility successful completed.

e Bundle and upload the completed page to the development board with MPFES utility.

MPLAB File » Open Project [

Lab2-C18-PICDN2-ETH97 . Xfor the PICDEM.net 2 with internal MAC/PHY setup
Lab2-C18-PICDN2-MRF24WB.X for the PICDEM.net 2 with Wireless MAC/PHY setup
Lab2-C30-EXP16-ENC28.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Lab2-C30-EXP16-ENC624.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Lab2-C30-EXP16-MRF24WB.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Lab2-C32-EXP16-ENC28.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Lab2-C32-EXP16-ENC624 .X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Lab2-C32-EXP16-MRF24WB.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

i

£= SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

IIIEIIIIII

BUILD TO CONFIRM NO SYNTAX ERRORS

o

—llﬁ‘—ll —ll SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Open Wireshark. Newer versions have a start up screen, and offer quick Network card selection and start of cap-
ture. Otherwise use the following to select the card and start a capture, as indicated in the next two screen shots:
1) Select CAPTURE/OPTIONS

2) Then select your PCs Ethernet card, Promiscuous mode, and Start a capture

Al The Wireshark Metwork analyzer

Eile Edit Wi S0 Capture analyze Skatistics Help

Eilter: I

Inkerfaces. ..

=

Dpkions, .. ZErl4-K
Skark
Stop —Erl-HE

Eestark

RERe

Zapture Filkers. ..




Ensure that Cap-
ture packets in
promiscuous mode
is checked.

(

Tl wireshark: Capture Options

=10l x|

rCapture

IP address: 169.254.0.2

[¥ Capture packets in promiscuous mode

[ Limit each packet ko |68 jbytes

Interface: IlnteI(R) PRO1000 MT Mobile Connection {Microsoft's Packet Scheduler) ; \Device\NPF_{E

Link-awer header bype: | Ethermest [ gl |BuFFer size: |1 ﬂ megabyte(s)  Wirsless Settings |

Select your PC’s
network card in the
Interface drop down
box.

Capture Filter: | I

=

ri_apture File(s)

File: I

Erowse... |
|1—ﬂ megatykels) IV

[~ Use mulkiple files
I~ Mexzt file every

I~ Mexzt file every l b g

¥ Ring buffer with |2 ﬂ files
[ Stop capture aftet Il ::’ filels)

|1 ﬂ minutels)

~Skop Capture ...
[ ... after |1 ﬂpacket(s)
|1 ﬂ megatytersy

Iv

[ ... after
[ ... after |1 il minutels)

[

rDisplay Options

¥ Update lisk of packets in real time
[¥ automatic scrolling in live capture

[¥ Hide capture info diglog

rMame Resolution

[¥ Enable MAC name resolution

[ Enable netwark name resoluti

[¥ Enable transport name resolul

Help |

Click Start button to
start capturing pack-
ets...

Start i Cancel

STOP the capture after you see packets being captured in Wireshark. The figure below shows
Wireshark with its three main panes: Packet List, Packet Details, and Packet Bytes. The Stop icon is
shown below.

74! Broadcom NetXtreme ‘Gigabit Ethernet Driver - Wireshark .

File Edit View Go Capture Analyze Statistics Telephony Tools Help

-lofx

e DE@RBE|AQ e

ok N EIEN e

Filter: I ¥  Expression... Clear Apply
No. |'Hrr|e |Saurce |Desﬁnaﬁcn |Pramcc\ |Info « o 499
2355 12. 583635 10.10.14.30 172.16.147.59 sPoOLS:ClosePrinter response Packet List” Pane
2356 12.583721 172.16.147.59 10.10.14.30 SPOOLS:OpenPrinterEx request, \\CHANDLER-PRT\C3_1 NE
2357 12.600483 10.128.1.104 172.16.147.5% DCERPC Bind_ack: call_id: 3 accept max_xmit: 4280 max_recv: 4280
2358 12.600557 172.16.147.59 10.128.1.104 SPOOLS:OpenPrinterEx request, \\mtv-sv-print\MTV-SALES-COLOR
2359 12.628825 10.10.14.30 172.16.147.59 SPOOLS:OpenPrinterEx response, Invalid printer name
2360 12.630671 10.10.14.30 172.16.147.59 SPOOLSSOpenPrinterEx response
2361 12.630693 172.16.147.59 10.10.14.30 TCP z-wave > netbios-ssn [ACK] Seq=50283 Ack=27132 Win=62896 Len=0
2362 12.630793 172.16.147.59 10.10.14.30 SPOOLSSEnumlobs request, Tlevel 2
2363 12.639189 10.128.1.104 172.16.147.59 SPOOLSSOpenPrinterex response
2364 12.639307 172.16.147.59 10.128.1.104 SPoOLSsEnumlobs request, Tlevel 2
2365 12.675450 10.10.14.30 172.16.147.59 SPOOLSSEnumlobs response ¥

Frame 1: 93 bytes on wire (744 bits), 93 bytes captured (744 bits)

ethernet II, src: cisco_75:7f:80 (00:13:1a:75:7f:80), Dst: usi_52:fe:ed4 (00:16:41:52:fe:ed)

Internet Protocol, src: 10.10.14.30 (10.10.14.30), Dst: 172.16.147.59 (172.16.147.59)

Transmission control Protocol, Src Port: microsoft-ds (445), Dst Port: wap-push-https (4036), sSeq: 1, Ack:

NetBIOS Session Service
SMB (Server Message Block Protocol)

“Packet Details’’ Pane

1, Len: 39

ed
00
4
00
cB
fe

00
79
ch

Y&
of
33

T
Oa
b9

80
Oa
g

00
03

00
24

00
00

00
00

File

Edit  Wiew Go

1000 MT Mobile Con

Capkure

“Packet Bytes’” Pane

anal

Q| @ | ¢

Filker: I_I Stop the running live capture I_
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° Enter a filter to look for DHCP protocols. Either use the expression builder or type directly into the filter bar.

Bootp is a protocol keyword for DHCP.
RESTART the capture again via the Start ICON shown below, disregard the request for saving.

PRESS the Master Reset button on the board. STOP the capture and investigate the bootp packets.

Wireshark Filter Bar

71! Broadcom NetXtreme Gigabit Ethernet Driver - Wireshark

Fle Edt View Go Captwe Analyze Statiscs Telephony Tools Help
BUUONDEX2LIA¢99TLDB|QARMAIBED%|B

Filter: |booh:| ¥ Expression... Clear Apply

| Nieatinatinn | Pratrrnl | Tnfn

74! Broadcom NetXtreme Gigabit Ethg

File Edit Wew Go Capture Anal

hin | Time Sniirre

% ﬁ. Start New Capture

Filter: Ihnnh‘l

° Use the Ethernet Discoverer executable from Microchip tools to confirm your dev tool’s IP address.

Start » Programs » Programs » Microchip » 1538 » Microchip Ethernet Discoverer

Network Discoverer

: Microchip Ethernet Device Discoverer

i | Discover Devices I

IP Address | Host Name | MAC Address
192.168.0.100  MCHPEOARD 00-04-A3-10-17-46

e Change the filter again to only show your board’s IP address.
Type it into the filter bar or use the Expression Builder.
a. To filter for all traffic with an IP address or destination source and destination use
the following filter, ip.addr == <IP Address> with your board’s IP address
b. If you find too many results, filter on HTTP as well : Example: ip.addr == <IP Address> && http
Notice the capture window is reduced to frames only associated with that IP address.




@ RESTART the capture. Open a web browser and point to http://UNIQUE-NAME/ specified in Lab 1. Stay on the
STATUS page which is default when receiving the index.htm page. STOP the Wireshark capture sequence.
Observe the frames monitored by Wireshark. Note the TCP socket connection frames.

5\ Mcrackp COM4301 DEMo APP

Status | Lights | Products

MCHPBOARD :: Building C4 - 2nd Floor NW

Q View the capture in Wireshark utility to follow a TCP Stream for Payload and Socket processing.
Use the ‘Find Packet...” command to display only the packets associated with the TCP transaction for
the index.htm page loading. Select this from the menu > Edit > Find Packet, or Ctrl-F.
Notice the packet where the first instance of the string is found is highlighted, shown on the screen at
the top of the next page.

1 {Untitled}) - Wireshark
File | Edit Miew Go Capture Analyze  Statiskics
oy ]

' Find Packet. .. Ckrl+F

Helpful Suggestions for Wireshark Packet Finding

When a browser sends a request for a file from an HTTP server, it sends out the request in ASCII text. Therefore, the
Find dialog box should use the ‘String’ search filter. Also, start with the packet finder searching in the PACKET LIST, as
shown in the display below.

il 71" Wireshark: Find Packet ;IEIEI

-Find
[ By: {" Display filter {— Hexvalue (* Siring
T [
. rSearch In———— String Options Direction—
i | (% Padketlist [T Case sensitive " Up
' | Packet details | | Character set: {* Down
i | T Packetbytes IASCII Unicode & Mon-Unicode "|

I Help | Find Cancel
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22 4.275936 Usi_52:fe:ed Broadcast ARP who has 192.168.0.1067 Tell 192.168.0.101

23 4.276945 Microchi_00:4c:90 Usi_52:fTe:e4 ARP 192.168.0.106 is at 00:04:33:00:4c:90

24 4276950 192.168.0.101 192.168.0.106 TCP redstorm_find > http [5¥N] Seq=0 win=64240 Len=0

25 4.279851 192.16%8.0.106 192.168.0.101 TCP http > redstorm_find [S¥N, ACK] Seq=0 Ack=1l wWin=l

26 4.279865 192.168.0.101 192.168.0.106 TCP redstorm_find > http [ACK] Seq=1 Ack=1 Win=64240
7 4 GET /index.htm HTTP/1.1

28 4 168.0.106 192.16E8.0.101

. 284565

192, TCP http > redstorm_find [ACK] Seq=1 Ack=408 wWin=159:

30 4.303713 192.168.0.106 192.168.0.101 TCP tTCP segment of a feassemb1ed PDU] B

31 4.308014 192.168.0.101 192.168.0.106 TCP redstorm_info > http [5¥N] Seq=0 Win=64240 Len=0 LI
1 | o
# Frame 27: 461 bytes on wire (3688 bits), 461 bytes captured (3688 bits) ij
@ Ethernet II, src: Usi_52:fe:ed (00:16:41:52:Ffe:ed), Dst: Microchi_00:4c:90 (00:04:a3:00:4c:90)

8 |= Internet Protocol, Src: 192.168.0.101 (192.168.0.101), Dst: 192.168.0.106 (192.168.0.106)
El Transmission Control Protocol, Src Port: redstorm_find (2347), Dst Port: http (B0), Seq: 1, Ack: 1, Len: 407 ‘:J

S T - S R e e ¥ B 1Y

2| | >
0000 00 04 a3 00 4c 90 00 16 41 52 Te e4d 08 00 45 0O AR -
0010 01 bf 2c 78 40 00 80 06 4a al cO a8 00 65 c0 a8 B (o B e e

0020 00 6a 09 2b 00 50 57 7e a5 36 3e bz 7b 1f 50 18 .+ Pw~ L6>.{.P.

0030 fa fO 83 d1 00 00 47 45 54 20 2f 69 6e 64 65 78 ...... GE T /index

0040 2e 68 74 6d 20 48 54 54 50 2f 31 2Ze 31 0d 0Oa 41 .htm HTT P/1.1..A

0050 63 63 65 70 74 3a 20 2a 2f 2a 0d 0a 52 65 66 65 ccept: * /¥, Refe
0060 72 65 72 3a 20 68 74 74 70 3a 2f 2f 6d 63 68 7 rer: htt p://mchp
0070 62 6f 61 72 64 2f 6c 69 67 6B 74 73 2e 68 74 bd board/1i ghts.htm

0080 Od Oa 41 63 63 65 70 7 2d 4c 61 6e 67 75 61 67 . .ACcept -Languag

0090 65 3a 20 65 6e 2d 75 73 0d 0a 55 73 65 72 2d 41 e: en-us ..User-A

00a0 7 65 6e 74 3a 20 4d 6f 7a 69 6c 6c 61 2f 34 2e gent: Mo zilla/4.

nohn 30 70 PR AT AF Ad 70 A1 A RO R? A RS 2h 70 Ad N fromna Tihla: wm d

@| Broadcom MetXtreme Gigabit Ethernet Driver: <li... |Pad<e15: 5844 Displayed: 5844 Marked: 0 |Proﬁ|e: Default &
RESTART the capture.

Select the lights webpage heading in the browser at the top of the screen.
STOP the Wireshark capture sequence. Observe the frames monitored by Wireshark.

Now use the ‘Find Packet...” command to display only the packets associated with the TCP transac-
tion for the lights.htm page loading. Select this from the menu > Edit > Find Packet, or Ctrl-F.

T (Untitled) - Wireshark
File | Edit Wiew @o Capture Analvee  Statistics
e ) b

B Find Packet, ..
1 wireshark: Find Packet =10 EI

| -Find
By: { Display filter {— Hex value {* String

gt

" rSearch Im String Options Directon —
" Packet list [T Case sensitive " Up
{~ Packet details || Character set: ®* Down
{~ Packetbytes ASCII Unicode & Mon-Unicode S

| Help Find Cancel
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Untitled) - Wireshark ;IEILI

File Edit Vew Go Capture Analyze Statistics Help
o e BEX28 AaesnTFi|EBEB Qaan @®mx| B

Filter: |(‘ip.addr eq 192.168.0.101 and 1ip.addr eq 192.1 ~ Expression... Clear Apply

No. - | Time | Source | Destination | Protocol | Info ;I
11 18.897467 192.168.0. 192.168.0. plgproxy > http [S¥YN] Seq=0 win=64240 Len=0 MsS5=1460
12 18.900368 192.168 192.168 http > plgproxy [S5YN, ACK] Seqg Ack=1 win=1001 Len=

18.906285  192.168.0.10 192.168. 0.
10 18.9252310 102.168.0. 192.168. 0. : [TCP segment of a reassembled PDU)
20 18.935836 _ 192.168.0. 192.168.0.10 HTTP/1.1 200 oK (text/html)
28 18.940635 192.168.0. 192.168. 0. Attp > plgproxy LACK] Seq—
1 | _'I
M Flags: 0x10 (ACK) ;l

Window size:

64240

, should be 0x1f8b (maybe caused "TCP checksum

= Hypertext Transfer protocol
= GET /lights. htm HTTP/1.1\r\n

Request Method: GET
Request URI: /lights.htm
RequesT version: HTTP/1.1

[truncated] Accept: image/gif, image/jpeg, image/pjpeg, image/pjpeg, application/x-shockwave-flash, application/vnd.ms-ex
referer: http://rob/products. htm'rin

Accept-Language: en-usirin

User-Agent: Mozilla /4.0 (compatible; MSIE 7.0; windows NT 5.1; Trident/4.0; .NET CLR 1.1.4322; InfoPath.l; .NET CLR 2. 0

< |

D030 Ta 10 B4 4e 00 00 47 45 54 20 RIS CHTECEIE] ... MN.-GE T m T
0040 20 48 54 54 50 2f 31 2e 31 Od Oa [EEEED HT TP /1.1

0050 41 63 63 65 70 74 3a 20 69 6d 61 67 65 2f 67 69 Accept: image/gi _|
0060 66 2c 20 69 6d 61 67 65 2f 6a 70 65 67 2c 20 69 f, image /jpeg, i

0070 6d 61 67 65 2f 70 6a 7 65 67 2c 20 69 6d 61 67 mage,/pjp eg, imag
0080 65 2f 70 6a 70 65 67 2c 20 61 70 70 6C 69 63 61 e/pjpeq, apEHca
hoc

0090 74 69 6F 6e 2f 78 2d 7 68 6f 63 6b 77 61 76 65 tion/x-s wave
00a0 2d 66 6c 61 73 68 2c 20 61 70 70 6C 69 63 61 7 -flash, applicat
00b0 69 6f 6e 2f 76 6e 64 2e 6d 73 2d 65 78 63 65 6¢C 'ion,fvr'ld. ms-excel
00cO0 2c 20 61 70 70 6c 69 63 61 74 69 6f 6e 2f 76 6e ., applic ation/vn LI
HTTF Request-URI (http.request.uri), 11 bytes |Packets: 46 Displayed: 13 Marked: 0 Dropped: 0 |Pmﬁ|e: Default 4

Once the desired packet is found, you can right click on that packet in the packet list pane to get a context menu. Use the
‘Follow TCP Stream’ option. Close the screen shown below that opens automatically. Notice the filter contents change to
only the requested details.

1G.10.5. 75 TR L
EN= ] Mark Packest Ctaggle) -4=
.l C5r Sek Time Reference (togale) =
d1a.1 0 (o]
spply as Filker -
Frepare a Filter =
Conwersation Filker L3
S=TE >

aquances
Thiwe se
Thiwe ac

Fallaws S5l Skreann

Copw -
Export Selected Packset Bykes. ..

HBE Decode as. ..
=Y Primk...
Showve Packet in Fevs Windows

=T =
e

T AS—— —

i GAmage S Jdpeg. i i i kwawve_flash.

—excel app 1
<amlt=xmi, Dp1}£at1clﬂ/vﬂd ms
Erel N U N
rRefereaer : http : //192 168 O. L0
Eoreos Enrme e =
S EPPE LAY RS 1T o coompat oae;
s e =

_.‘..H
20
n
n
n
6%
[
\
o
33

SPplicatyons
>

T
I

T el S . 05 L NET CLR
o = Fa=Y
RTC LM 83

ke onnecTion: Keep—albdwe

HTTP 1.1 oo ok
lconnmocction: closc

lcontent_—Twpe: Textshtml
lcache comtrol: no-—cache

<! pocTYPE hEtml PUBLIC ~— WIC,/ /DTD XHTML 1.0 STRICT//EMT "Drosxhetmll_-strdce. ded™=—

SL e e ook webvend Domo ApposL sl e
STk href—ovending. cest rel—"EEnlashest T Type—TtaxtiocssT S

T Ad—"EdrleT-=div class—"pageT~
—bi 1A ?"r‘igh TecomMa>al pemo AappeSdius
e e

L R Rvee § R

—diw_ G
b =2l4g

Eris i . fe=i

Eina | Save as | Prlntl Entire conversation (2340 bytes) [ = |« ascm « eBcDIC — HexDump ' C Arrays = Raw

= | —

WE YL LA
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Results

The Wireshark utility has been used to monitor the communication from a PC browser to the MCU acting as a webpage
server. Specific IP addresses were filtered for, and a TCP communication stream was observed.

Analysis

Wireshark can be used to investigate the communication traffic by inserting a PC into the network. The utility can be used
to see all traffic, or can be configured to filter traffic for a defined subset of the communication partners. Filters can also be
used to track specific protocols and therefore help the designer confirm their firmware is behaving as expected.

@ Bonus Procedure

Figure out how to display only the packets associated with the TCP associated with downloading the mchp.gif
file inside this design. Use the ‘Find’ command by selecting:
> Edit > Find Packets...

75l wireshark: Find Packek o ] |

-Find

By € Display Filter ' Hewx walue (% Skring

Filker: ||mchp. gif

rSearch In

Skring S pkion: Direckion—
= Packet lisk [T Case sensitive " Up
("~ Packet details | | Character set:

|AscII Unicode & Mon-Unicods | I

Help | Eind I Cancel

@ After finding the packet, ALTER THE TIME COLUMN PARAMETERS to suit your need for the timing calcu-
lation. Then USE FOLLOW THE TCP STREAM FEATURE. Application transmit performance can be
calculated by: (mchp.gif file size)/(time elapsed for entire TCP transaction).

s Down

{® Packet bytes

Wireshark Menu Altering

The Time column in Wireshark can be configured to display several different values (time since beginning of capture,
time since last packet, etc.). Remember that right clicking on a packet in the packet pane will bring up a useful menu.




g2 rotlow TcPstream 1oy 1
t rStream Content
f | IGET Aindex.htm HTTP/1.1 -

laccept: ® /% —
i rReferer: http://rob/lights. htm?Tights=

laccept-Language: en-us

User—-agent: Mozilla/4.0 (compatible; MSIE 7.0; windows NT 5.1; Trident/4.0; .NET CLR
1.1.4322; InfoPath.l; .NET CLR 2.0.50727; .NET CLR 3.0.04506.30; .NET CLR

3.0.04506. 648; .NET CLR 3.0.4506.2152; .NET CLR 3.5.30729; MS-RTC LM 8)

Isccept-Encoding: gzip, deflate

Host: rob

Iconnection: Keep-Alive

HTTP/1.1 200 OK

iconnection: close B
IContent-Type: text/html

iache-control: no-cache

l<!DOCTYPE html PUBLIC
l<html>

: | [<khead>=

E <title>Microchip webvend Demo App</title>

| l<link href="/vending.css"™ rel="stylesheet"” type="text/css" />
< /head>=

<body=

l<div id="title"><div class="page'=>

[ l<diwv class="right">CcoM4301 Demo App-</diwv>
| <EE'iv>—<E1v class="spacer"></div=</div=
l<diwv_ id=""content’' >

-<E align="center” style="margin-top: 0">
l<b>status<,/b> &nbsp;%,

S /W3C//DTD XHTML 1.0 STRICT//EN" "DTD/xhtmll-strict.dtd” >

Rnbsp; v|
L | | |
Find | Save As | ErintI Entire conwversation {2297 bytes) [ - |r ASCII { EBCDIC & HexDump { C Arrays ® Raw

Help | | Close I Filter Qut This Stream |
7l (Untitled) - Wireshark . i [l JE}

File Edit View Go Capture Analyze Statistics Help

Bowe BEX@ola¢r»aT2|BE/QQQAD | E0M%| 8
Filter: |('ip.addr eq 192.168.0.101 and ip.addr eq 192.1 ¥ Expression... Clear Apply
No. - | Time | Source | Destination | Protocol | Info -
1 0.000000 192.168.0.101 192.168.0.100 TER venus > http [SYN] Seq=0 Win=64240 Len=0 M55=1460 WS-
TCP

2 0.001917 192.168.0.100 192.168.0.101 http > venus [SYN, ACK] Seq=0 Ack=1 wWin=1001 Len=0 M

50.007434  192.168.0.100 192, http > venus eg=1 Ack=405 Win=1596 Len=0

" 0.037065 l. .Ij.iDlj DlDl TéP segment ﬁu a'rea-nem e' #bu ' ” )

15 0.094149 .168.0.100 .168.0.101 HTTP/1.1 200 OK (text/html)

18 0.006777  192.168.0.100 107,168, 0.101 ; http > venus [ACK] 5eq=1805 Ack=406 Win=l Len=0 -

4 | |

Sequence number: 1 (relative sequence number) -
[Mext sequence number: 1023 (relative sequence number)]
Acknowledgement number: 405 (relative ack number)

Header length: 20 bytes
Flags: 0x18 (PSH, ACK)
window size: 1
checksum: 0x1f00 [correct]
TCP segment data (1022 bytes)

bl

">COM43 01 Demo

55= 5

"4 Bonus Code Analysis

Wireshark can be used for performance analysis by using the time column for calculations. Application transmit per-
formance can be calculated by: (application subset file size)*(time elapsed for entire TCP transaction)/total applica-
tion file size.
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Lab Exercise 3

Integrating an Application with the Stack

g Purpose

For many designs, you will be integrating an existing application with the stack. For new designs, it is still impor-
tant to understand the fundamental design of the stack and where to place your application’s code.

In this lab, you will take the example vending machine application demonstrated earlier and integrate it with the
stack. Due to the complexity of the stack, it is generally easier to integrate your application into the stack rather
than the other way around. This lab will walk you through those steps, and upon completion the vending ma-
chine and the stack will be operating separately within the device. The following labs will focus on them working
cooperatively.

Requirements

Software: Completed Lab 1 to support network settings

Environment: MPLAB® IDE 8.60, X, or later, 1538 Masters Installer 1.536

C Compiler: MPLAB C18 v3.38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ , or MPLAB ICD 3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Lab3...

Objectives

® Experience the procedural steps for combing an existing firmware application with the TCP/IP stack
® Practice identifying the desirable locations for the firmware application within the TCPIP stack.

C:\Masters\1538\Lab3\*

rﬁ C:\Masters\1538\Vending Machine\VendingMachine.*

The Vending Machine application is implemented in the Vending Machine Project Direc-
tory above. The core of the application is implemented in two source files.

Procedures

3-1
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(]
o MPLAB File » Open Project %

Lab3-C18-PICDN2-ETH97 for the PICDEM.net 2 with internal MAC/PHY setup
Lab3-C18-PICDN2-MRF24WB for the PICDEM.net 2 with Wireless MAC/PHY setup
Lab3-C30-EXP16-ENC28 for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Lab3-C30-EXP16-ENC624 for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Lab3-C30-EXP16-MRF24WB for the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Lab3-C32-EXP16-ENC28 for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Lab3-C32-EXP16-ENC624 for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Lab3-C32-EXP16-MRF24WB for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

Lab 3 project directory. Use Windows Explorer or My Computer.

Add the two files you copied to your MPLAB project. You may need to select “All Source And Header Files”
from the dropdown list for “Files of type” in order to see both the . c and .h file. Project » Add Files b
VendingMachine.c and VendingMachine.h.

Stack/TCPIP.h” just below as shown. These headers and insertion integrate this file with TCPIP stack files.
Save the changes you make. File P Save

Copy files VendingMachine. c and VendingMachine.h from the Vending Machine directory to the

Open VendingMachine.h and Comment out the section “Required Headers”. Also Insert #include “TCPIP

a VendingMachine.h

._.'.RRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRR
Section:
Required Headers

f#include "Compiler.h™
f#include "GenericTypeDefs.h"
f#include "HardwareProfile.h"
f#include "Delay.h"
ff#include "LCDElocking.h™

#1nclade "TCPIP Stack/TCPIP.R"

Open MainDemo.c and Insert #Include VendingMachine.h in so as to gain access to the vending machine
application data. Place this directly below the directive for MainDemo.h. line.

MainD
alnvemo.cC
.
[El+include "TCPIP Stack/ZeroconfMulticastDNS.h"
gl #endif
#M// Include functions specific to this stack application
gEl#include "MainDemo.h
gf¥#1nciude “VendingMaching].h™
gl]// Used for Wi-Fi assertions
YWl#define WF_MODULE_NUMBER WF_MODULE_MAIN DEMO
79 // Declare AppConfig structure and some other supporting stack variables
Mann ~areT e A Ed
v
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Insert a call to the vending machine’s initialization function InitializeVend () inmain (). This should be
placed immediately following the call to InitAppConfig () on line 262.

a MainDemo.c

// required by the UART configuration routines
Tickinit();

#if defined(STACK USE_MPFS2)

MPFSInit ()7

#endif

// Initialize Stack and application related NV variables into AppConfig.
InitAppConfig();
InitializeVend();

// Initiates board setup process if button is depressed
// on startup

if (BUTTONO_IO == 0Qu)

{

#if defined (EEPROM CS TRIS) || defined (SPIFLASH CS TRIS

Replace the contents of ProcessIO () from line 644. Instead of performing an A/D conversion, call Vend—
ingMachine () to perform any necessary vending machine tasks.

a MainDemo.c

g @ MainDemo.c | & Vendnghachineh |
LCDText [LCDPos] = 0;
LCDUpdate () 7
#endif

[Z
q
G
L

o+

Function:
static void InitializeBoard (void)

and define the state machine used by for the vending machine application. The LCD Func-
tions section writes the various menus to the LCD display. Finally, the Initialization section
configures the product names, prices, and stocks when the device boots.

m The Application Global Variables within Vending Machine.c declare the storage locations

@ VendingMachine.c-Global Variables

== Section:
a0 Vending Machine Application Global Variables

/' Bll items=s in the machine
Machine description strinng
Current product being display
Current deposit creditc, as oo

WVEND ITEM Froducts [MAX PRODUOCTS] -
EYTE machineDesc[33] 7

BYTE curItem:

BYTE curCredit:

static enuam

SHM IDLE = Ou, Ho ewvents are pending
SHM DEBOUNCE DOWH, Button press detected. . .wverify the ew

T e Ve ST a DU LTITT LDIITITTILA )
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J/f Display the boot message on the LCD
strepypgm?ram( (char®) LCDText, "Microchip Vending Machine™);
LCDUpdate () ;

SRR R R R R R R R R R R A AR R R R R A AR AR AR R R R A AR R R AR AR R R A AR AR AR AR R A A AR AR R R AR R A AR R AR R R R R R A

Section:
Vending Machine LCD Functions
R L L L T T T
static vold WriteLCDMenu (void)
{//f Update the LCD screen

/f Blank the LCD display
LCDErase () ;

J/ Show the name
strepy ( (char*) LCDText, (char*)Products[curltem] .name) !
LCDText [strlen( (char*)Products [curltem] .name)] = ' ':

// Bhow the price, or sold out status

if (Products[curltem] .stock == 0)
memcpypgm2 ram (&LCDText [12], (RCM woid+=) "SCLD™, 4):

else

\,

VendingMachine.c: Initialization

Section:
WVending Machine Initialization

e e R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R O R R R R R R R R R R R R R o R R o R R R R R R R R R R R R R R R o R R

wvold InmitializeVend (wvoid)

S Vending machine specific defaultos

strocpypgm2ram | (char®) Product=s[0] .name, (ROM char+®)"Cola™):
strocpypgm2ram | (char*) Product=s[1] .name, (ROM char®)"Diet Cola™) :
stropypgmZram( (char*) Product=s[2] . name, (ROM char®) "Root Beer™):
strocpypgm2ram | (char®) Product=s[3] .name, (ROM char+®*) "Orange™) ;
strocpypgm2ram | (char®) Product=s[4] .name, (ROM char+®*) "Lemonade™) ;
strocpypgm2ram | (char®) Product=s[5] .name, (ROM char+®*)"Iced Tea™):
strocpypgm2ram | (char®) Product=s[6] -.name, (ROM char®) "Watcer™) ;
Productcs[0] .price = 4;

Productcs ] .price = 4;

Products= .price = 4;

Productcs price = 4;

Productcs .price = 5;

Products .price = T:

Productcs .price = &;

Products .stock = 15;

FProducts -stock = 9;

Products .stock = 22;

Products .stock = 18;

Froducts .stock = 4:

Products .stock = 2%9;

Products .stock = 14;

strocpypgm2ram | (char*)machineDesc, (ROM char®*) "Building C4 — 2nd Floor HW™) ;
machineDesc[32] = "“0O°':

curItem = 07

curCreditc = 0;

/S Display the boot message on the LCD
stropypgmZram( (char* ) LCDText, "Microchip Vending Machine™) ;
LCDUpdate () =

240 K
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SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Verify that the vending machine operates as discussed in the initial demo. Unexpected output on the LCD
display will be corrected in the next step.
Verify that the web pages accessed during Lab 2 are still available.

In some versions of the stack, annoying messages are received on line 2 of the LCD display. If that occurs;
Comment out the call to PingDemo () in the main program loop to disable this output.
The “Ping timed out” message is generated by the ping demo when the right-most button is pressed.
Comment out the call to DisplayIPValue ()as it writes the IP address to the LCD .
These deletions will eliminate the output of extraneous data to the LCD.

a MainDemo.c

3-5

S /PingDemo () ;
#fendif

#if defined (STACE_USE_SNMP_SERY
/#User should use cne of the fo

R} s& !defined(SNMP_TRAP DISRABLED)

owing SHMP demo

/¢ This routine demonstrates V1 or VZ trap formats with one varisble binding.
SNMPTrepDemo () ;

#if defined (SNME_STACE USE_VZ_TRAD)

‘This outine provides V rmat notifications with multiple (3) wariable bindings

4 uld modify this routine to send vZ trap format notifications with the reguired

i JZTrapDema () ;

gendif

if (gSendTrapFlag)
SHMESendTrap () ;

#endif

#1f defined(STACE_USE
BerkeleyTCPClientDem
BerkeleyTCPServerDem
BerkeleyUDBClientDemo (] ;
fendif

EREELEY_API)

ProcessIO(l;

/ If the local IP address has changed (ex: due to DHCP lease change)
/f write the new IP address to the LCD display, UART, end Ennounce
ervice
if(dwlLastIP != AppConfig. MyTIPAddr Val)
{

dwLastIP = RppConfig.MyIPAddr.Val;

§if defined (STACE_USE_UART)
putrsUART ( (RCM char*) "“r\nlew IF Rddress: ™);
gendif

//DisplayIPValue (AppConfig. MyIBAddr) ;

$if defined (STACE_USE_UART)

varbinds.
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E SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
8 TIONS. Build and Program the firmware into the selected device in RELEASE mode.

BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Confirm the Router assigns an new IP Address.
Verify that the undesired messages no longer appear on the LCD screen.

Results

Your project now has a vending machine operating simultaneously with the TCP/IP Stack. While the two func-
tions do not interact with each other yet, the basic functionality is working

Code Analysis

The vending machine application was implemented as a state machine, which is common for many simple micro-
controller-based systems. Since each state executes for only a brief period, it was relatively easy to integrate into
the stack. However, the general model and code placement applies for more complex applications as well.

In general, initialization code should be called after the InitAppConfig() call. This code will be executed once
when your device boots. Application code should be placed either at the end of the main stack loop or in the
ProcessIO () function.

(O3 Conclusions

Although no new functionality has been gained, the vending machine is now much closer to being network-
enabled. Integration with the stack is the most challenging task because it requires (in many cases) a new way of
thinking about the application. A few integration issues still remain, which will be explored in the next lab.
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Lab Exercise 4

Remove Blocking Code

g Purpose

Networked applications must handle a significant amount of background processing in order to keep the network connection
alive. To accomplish these time-sensitive events, the Microchip TCP/IP Stack operates in a co-operative multi-ta sking
fashion. This eliminates the need for an RTOS, as well as the need for interrupts and overhead.

However, it means that your application must be implemented without any code that may block the processor. In this lab,
you will witness how a blocking loop can affect the TCP/IP Stack, and will learn how to take steps to avoid such loops in
your application.

Requirements

Environment: MPLAB® IDE 8.60, X, or later, 1538 Masters Installer 1.536

C Compiler: MPLAB C18 v3.38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO0 or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ , or MPLAB ICD 3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Lab4..

Objectives

® |dentify non-conforming application code that can disrupt the required operational flow of the TCP/IP stack
® Practice making application code modifications to ensure compatible coexistence of two code sets

m Procedures

Confirm the operation of the blinking LED per the description below:.

With your application from Lab 3 running, notice the blinking status LED on your development board. What hap-
pens to that light when a message change is displayed on the LCD? (The effect is most visible when you attempt
to insert more than $5.00 of credit into the machine.) Stable blinking operation of this LED signifies that the TCP/
IP Stack is being called frequently. When the status light is not blinking, the stack is not running and cannot re-
spond to incoming network traffic. The existing vending machine code uses a blocking loop to time the display
message. This needs to be corrected.

[ C:\Masters\1538\Lab4\*

4-1
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0 MPLAB File » Open Project

Lab4-C18-PICDN2-ETH97.X for the PICDEM.net 2 with internal MAC/PHY setup
Lab4-C18-PICDN2-MRF24WB.X for the PICDEM.net 2 with Wireless MAC/PHY setup
Lab4-C30-EXP16-ENC28.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Lab4-C30-EXP16-ENC624.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Lab4-C30-EXP16-MRF24WB.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Lab4-C32-EXP16-ENC28.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Lab4-C32-EXP16-ENC624.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Lab4-C32-EXP16-MRF24WB.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

e Open the vending machine source file VendingMachine.c. Locate the blocking FOR loop in the
SM_DISPLAY_WATIT state inside of VendingMachine (). This loop consumes processing cycles by
performing a meaningless task. Mark this loop as commented out as shown in the example below.

m About Timing Loops

A common method for implementing delays is to cause the processor to complete some
meaningless task, such as counting to 10,000, or to call one of the Delay () functions that
does this internally. However, code constructs such as these block the processor and
waste MCU resources that could otherwise be spent handling incoming Ethernet packets or
other network functions. Loops of this type should be avoided.

Instead, use the provided Tick module. The Tick module is interrupt-driven, and is based
on the hardware clock. It is stable and accurate, and can be used to implement non-
blocking delays by comparing current times to timeouts. Since it is hardware-based, it is
also suitable for use as a Real Time Clock.

y

N
Insert a comparison of TICK values to determine if enough time has elapsed. If the timeout has occurred, advance
the state machine. Otherwise, just break and return to the main stack application. The stack will call the vending
machine to perform the comparison again later. Use the example shown below.

N\
a VendingMachine.c

169 break;

170

171 case SM DISPLAY WAIT:

172 // Wait for the timout to occur before continuing

173 //for(displayTimecut *= 1000; displayTimeout > 0; displayT

174 // DelayMs(1); [

175 if ( (LONG) (TickGet () - displayTimeout) > (LONG)O0)

176 smVend = SM_SHOW_MENU;

177 break;

178

178 case SM SHOW MENU: 4
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Change the declaration of this value at the top of VendingMachine () to its initialization to indicate two sec-
onds rather than just the number 2. Use the macro TICK_SECOND to calculate this value. Your code should
match the sample below.

VendingMachi
endingMachine.c
82
83
R T
Section:
Vending Machine Implementation
B e T
EElvoid vVendingMachine (void)
static DWORD displayTimeout = (2 * TICK_SECOND) ;
// Vending Machine State Machine
switch (smvend)
{
case SM_IDLE:
// Wait for a button press
if (BUTTONO_IO == 0 || BUTTON1 IO == 0 || BUTTON2_IC == 0 || BUTTON3_IO == 0)
smvend = SM_DEBOUNCE_DOWN;
ac nNalaums (1) - 4

Change the two instances where displayTimeout is set. Use a relative time
based on TickGet () and TICK_SECOND as indicated below. The variable displayTimeout is now allo-
cated as a TICK and configured to expire on a relative timeout value. The last step in this conversion is to replace
the code the assigns absolute delays to displayTimeout with an assignment relative to the current TICK value.

@ VendingMachine.c A

strecpyvpgmZram | (char®) LCDText, (ROM char®*)"™ Coin F
LCDUpdate () :

displayTimeout = TickGet ()} + 4 * TICK SECCHND:
smvend = S5M DISPLAY WAIT:

¥
break:;

S Try to wvend a product
if (Products [curltem] . stock == 0}

case SM TRY WEND:

Product is sold out
strecpypgmdram( (char* ) LCDText, (ROM char=) "™ 501
}

el=ze if (Products[curltem] .price > curlCredit)

strecpypgmram( (char* ) LCDText, (ROM char®) "Price:
WritePricelCD (Products[curltem] .price, &) :
WritePricelCD(curCredit, 24):

}

el=e
strecpypgmZram | (char®) LCDText, (ROM char#) ™ WETLC
curCredit —= Products[curltem] .price;
Products[curltem] . stock——;

}

LCDUpdate ()

displayTimeout = TickGet() + 2 = TICK SECCHND:

smVend = SM DISPLAY WAIT:
break:
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]

SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

é\

D@ BUILD TO CONFIRM NO SYNTAX ERRORS

— 1
Wy

oy

]

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Verify that the vending machine still functions.
1. Ensure that your web pages from Lab 2 are still accessible via a browser.

2. Verify that the status LED continues to blink, even when a status message is displayed on
the screen.
i.  Testwhen vending is attempted with insufficient credit.
ii. Testwhen a coin is returned for depositing over $5.00.
iii. Testwhen a product is vended.
iv. Test when a product is sold out.

(o N

To use the tick module, replace the blocking call by checking the current time using TickGet. Then

add an additional state to wait for the timeout. Transition to this state and return to the main loop.

When the loop returns to your application, compare the stored value with the current time. You can
use simple subtraction, since Ticks are stored as signed integers and will automatically overflow. The
TICK_SECOND macro is based on the instruction frequency, and can be used for comparisons against
elapsed time. You can also multiply or divide this value to obtain various resolutions. Tick is an unsigned
value. Type-casting to LONG forces the result to be a signed value, which will automatically take care of
overflow. Assume a TICK is only one byte. Say TickGet is equal to 253, and TICK_SECOND/10 is actu-
ally 10. That means that “doneAt” will be set to 7 after overflow. When TickGet returns 255, you’ll have
255 —7. That’s 248, or 1111 1000b. Cast that to a LONG and the first becomes a sign bit. That binary
value equates to -8, and so -8 < 0 and your timeout has not yet happened. When TickGet rolls over and re-
turns 3, you’ll have 3 — 7. You’ll get -4 after the cast, and your timeout will fail. Once TickGet has incre-
mented 10 times you’ll be at 8. You’ll have 8 — 7, which will be greater than zero and your timeout will
succeed. This works in many other cases, but you may have to pull out some old binary arithmetic rules to
prove it to yourself.

4-4
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Al

Results

When the lab is completed correctly, the status LED will continue to blink without interruption while mes-
sages are being displayed on the LCD. This signifies that application is not blocking the processor and that
the stack can complete its tasks in a timely fashion.

Code Analysis

The examples provided in this lab implement a timer without blocking loops. A single state is used for
the timeout stage, and the various machine states can set when a timeout will occur. Timeouts are
stored in displayTimeout, which is declared as a TICK value. The timeout value is calculated as
the current time (obtained via TickGet () ), plus some multiple of TICK_SECOND. This method is suit-
able for measuring time differences from a few microseconds to a few hours. (It's companion methods
TickGetDiv256 () and TickGetDiv64K () are valid for a few weeks or several years, respec-
tively.) The value of TICK_SECOND is calculated from the value of Get InstructionClock () as
specified in HardwareProfile.h. TICK values are stored as 32-bit unsigned integers. When a time
increment is added (such as 2*TICK_SECOND), this could result in overflow. Similarly underflow may
result when the subtraction is performed. The subtraction of TICK values, when cast to a LONG, com-
pensates for this by reestablishing the sign bit. This allows for valid comparisons in all cases.

Bonus Procedure

Several calls to DelayMs () remain in the code to help de-bounce the pushbuttons. Since the stack loop now
executes between each state, see if any of these can be removed without affecting operation. This will be de-
pendent on your platform, as the faster processors may still loop too quickly to avoid the transient periods.

Conclusion

The vending machine is now completely integrated, and neither task will interfere with the other. With this com-
plete, you are now ready to being adding network features to the device.
The principles learned in these past two labs apply to all stack applications:

1. Break long tasks into states, allowing the stack to execute frequently.

2. Use the Tick module instead of blocking loops for timed events.

The co-operative multi-tasking methodology of the stack is flexible, and will consume as little or
as much processor time as the application supplies. If necessary, stack operation can be inter-
rupted by the application for a few hundred milliseconds up to even a few seconds. While this
is not desirable (and should not be a frequent occurrence), most network application protocols
will not time out until several seconds have elapsed without communication. However, the ap-
plication will risk overrunning its RX buffer and losing data during this time. As a general rule,
applications should attempt to run the main stack loop at least every 10 or 20ms, with 1-2ms
being the target for best performance.
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Lab Exercise 5 ﬁ

Web-based Monitoring with Dynamic Variables
The first network feature to be implemented for this vending machine is the ability to determine its stock remotely. Having

ﬂ Purpose

already decided upon a web page for monitoring, the next step is to link the vending machine data into a web page.
Example web pages have already been provided for this project. However, they are just static pages with no mechanism to
populate vending machine data into the page. In this lab, you will program the first page to display the product name and
remaining stock level as reported by the vending machine.

Requirements

Environment: MPLAB® IDE 8.60, X, or later, MPFS Utility, 1538 Masters Installer 1.536

C Compiler: MPLAB C18 v3.38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO0 or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ , MPLAB ICD3 or MPLAB ICD 2
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Labs5....

Objectives

® |mplement dynamic replacement of static variables within HTML files for web server applications
® Utilize Callback procedure methodology between the HTTP2 module and customer application firmware

r Web Page Directory:
’ C:\Masters\1538\LL.ab5\WebPages2

m Procedures

Confirm design files in the webPages?2 folder in Lab 5 match the sample Web Pages in
o C:\Masters\1538 folder

Open index.htm from the WebPages?2 directory in Crimson Editor.
Start » Programs P Crimson Editor » Crimson Editor
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e Replace HOSTNAME static text with a dynamic variable called ~hostname-~.

Replace Machine Location / Description textto ~machineDesc~.
Save your changes to the HTML code.

index.htm

Bl<h>Status</b> inbsap;|&nbap;

e3<a href="lights.htm">Lights</a> &nbap;|&nbap;
t3<a href="products.htn">Products</a>

i<div id="location"*Machine ~hostname~ :: ~machinelezsc~ </div>

ilil<div id="bargraph">

<div class="productname">~name (0)~</div>

0 Bundle and upload this modified page to the development board with MPFS utility.
Recall that the MPFS2 Utility generates H-TTPPrint . h, which must be compiled into your MPLAB pro-
ject prior to compiling with your dynamic variable callback functions in step 5 herein.
Start » Programs » Microchip » 1538 » MPFS2
No modifications to the utility configuration should be necessary. Click Generate and Upload to program
your new pages to the development board.

m How Web Pages are Bundled

Recall: The MPFS2 utility must be executed prior to compiling your project in MPLAB.

r—— = ——————= |
Web Pages | MPFS2 Your Embedded
Utility Application

yes

A 4

EEPROM

(HTTPPrint.h)
»| Internal Flash

(MPFSImg2.c)
I: Program Memory
MPLAB
CustomHTTPApp.c >
e e e = = = = = —

5-2
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C:\Masters\1538\Lab5\*

MPLAB File » Open Project

Lab5-C18-PICDN2-ETH97.X for the PICDEM.net 2 with internal MAC/PHY setup
Lab5-C18-PICDN2-MRF24WB.X for the PICDEM.net 2 with Wireless MAC/PHY setup
Lab5-C30-EXP16-ENC28.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Lab5-C30-EXP16—-ENC624.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Lab5-C30-EXP16-MRF24WB.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Lab5-C32-EXP16-ENC28.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Lab5-C32-EXP16—-ENC624.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Lab5-C32-EXP16-MRF24WB.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

Open CustomHTTPApp . ¢ within MPLAB’s project window.

Remove all the HTTPPrint_* functions within the “Dynamic Variable Callback Functions”
section (These callbacks are for the demo application, most of which are no longer needed.)
except for HTITPPrint_version () and HTTPPrint_builddate ().

a CustomHTTPApp.c (delete unused sections)

o

Continue deleting thru the lines on the next page

&
PR LR L LR L L L L L L L Ll L L L L L L J

f[rédddhabbaiat Tahd Scapg: Start the section delete here end continue to line LBQ7#e#éwsisd
PR L e L

// Determine which button
switch (mum)
{
caze 0:
mun = EUTTOND 107
break;
cage 1
mun = EUTIONL 107




CustomHTTPApp.c (delete unused sections)

pi-Eifvoid HTTPPrint status ok(void)

if (lastSuccess)

TCPPutROMString (sktHITE, (RCM BYIE*)"block™);
elae

TCPPutROMString (sktHITE, (RCM BYIE*) "none");
lastSuccess = FALSE;

if(lastFailure)

TCPPutROMString (sktHITPE, (ROM BYIE*) "block™);
elae

TCPPutROMString (sktHTTR, (ROM BYTE*) "none");
lastFailure = FALSE;

PR LR R L R R R L e R L R L R e R L L e L R e L L e L L L R L R e L s L e L E s Lt E et

PR e T I.Eb5 StEPE T‘nd the secticn delete heve R ey
IR L R R L L L L L L L L e L e L

a Insert a callback function named HTTPPrint_hostname () to this section of the file.
This function has no parameters and returns no value. Within the function, use
TCPPutString () to print the hostname from its RAM location, AppCon-—
fig.NetBIOSName, to the TCP socket, skt HTTP. For more information about call-
backs, refer to the info box labeled on the topic below..

a CustomHTTPApp.c

curHTTP.callbackPos = 0=x01;
if (TCPI=PutReady (sktHITPF) < strlenpgm( (RCM char*) DATE " " TIME ))
return;

curHTTP.callbackPos = 0=x00;
TCPPutROMString (sktHITP, (ROM woid®) DATE " " TIME ):

void HITFPrint version(void)

TCPPutROMString (sktHTITE, (ROM wvoid#*) VERSICON) :

voild HITFPrint hostname (voild)

TCPPutString (sktHITP, AppConfig.NetBIOSHame) ;




m About Callback Functions

Callback functions are a concept of event-driven programming. For the HTTP2 web
server, an event occurs when a dynamic variable is encountered in your HTML code. The
response, handled by your callback function, is to print text or data to the web browser.

You do not need to worry about how or when the callback is invoked. The HTTP2 server,
along with the HTTPPrint . h file generated by the MPFS2 Utility, take care of this for you.

J

\

"\
CustomHTTPApp.c
L l#define  CUSTCMHITFPAFP C -
YA ¥include "TCPIPConfig.h™
58 gk defined (STACK USE HTTF2Z SERVER)
All#include "TCPIP Stack/TCEIP.h"™
Bl finclude "MainDemo.h™ /4 Heeded for SavelbppConfig() protoctype
#include "VendingMachine.h™
wvolid HITPPrint hostname (void)
ITCPPutString (sktHTITP, AppConfig.HecBIOSHame) ;
wvolid HITPPrint machinelDesc (void)
if (TCPIsPutBReady (sktHITP) = 32)
curHTITP.callbackPos = 0x01;
return:
curHTITP.callbackPaos = 0=x00;
TCPPutString (sktHTITP, machineDesc) ;
V.

Add a second callback function named HTTPPrint_machineDesc () to this section of the file. This function
also has no parameters and returns no value. Adding this function is slightly more involved.

StepA, Insert a #include VendingMachine.h entry at the top of the file right after the existing #include Main-
Demo.h entry. This provides a reference to the machineDesc string.

StepB, Insert an if loop that uses TCPIsPutReady () to confirm buffer space. The machineDesc
string may be up to 32 bytes long, which is longer than the 16 bytes the HTTP2 web server guarantees are avail-
able. So, the HTTPPrint call must follow the ensuring of at least 32 bytes are free in the TCP buffer. If the buffer
is too small, set a non-zero flag in curHTTP . callbackPos and return, which will request to be called again
when more space is available.
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SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

BUILD TO CONFIRM NO SYNTAX ERRORS

)

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

T
2]

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Verify that the vending machine still operates as discussed in the initial demo.
Verify that the web pages have the dynamic variables have replaced the static values, specifically hostname and
location. The string for the location is set in VendingMachine. c, and can be modified there if desired.

m Confirm the Router assigns an new IP Address

Sample Web Page

3 Microchip WebVend Demo App - Microsoft Internet Explorer

Fle Edit View Favorites Tools Help
3-8 - ¥ [3 . |Agdress I@ http:/fmchpboard/

@MICROCHIP WEeBVEeEnD DeEmo App

Status | Lights | Products

Machine MCHPBOARD :: Building C4 - 2nd Floor NW
Product

Product
Product

Product

Product




r Web Page Directory (Destination):
’ C:\Masters\1538Lab5\WebPages2

Return to index.htm in Crimson Editor.

Replace each instance of the static string “Product” with a dynamic variable with a single parameter. Call this
variable ~name (1) ~, where i represents an index from O to 6. This adds dynamic variables for each of the
product names.

Replace each static instance of stock quantities with a dynamic variable. Name this variable ~stock (1) ~,
again with indices from O to 6. The stock is listed in two places for each bar. The first prints as text inside the
bar, while the second controls the display width of the bar. Be sure to replace both locations, but leave the em
designation. (The em is a standard print measurement.)

Ensure you replace all 7 instances for the product and stock entries.

Save your changes to the HTM file.

A
Iﬁ Index.htm

*++Lab5 Step3: Replace "... HOSTHAME" and "... Description™ with & dynemic varisbles "hostname” and "machinelesc” --»
iv id="location"r~hostname~ :: ~machineDesc~ </divr

*++Leb5 SteplZ snd 13: Replace esch 1 ct” with a
static instance quantity with 2 zble "stock(i

*#+Lzb5 Bonus Stepli: Replace sach fixed "bar-in..." statement with = the dynamic varisble "status(i)"™ —-->
EE where i is 0 thru & -

<div class="productname">~name (0)~</div>

<div class="bar-out" style="width: ~stock(0)~em">
<div class="bar-in-ok"¥~stock(0)~</div>

</diwv>

<div class="productname">~name (1)~</div>

<div class="bar-out" style="width: ~stock(l)~em">
<div clazzz="bar-in-ok">~atock(l)~</div>

</div>r

<div class="productname"r~name(2)~</div>
<div class="bar-out" style="width: ~stock(Z)~em">

<div class="bar-in-ok"r~stock(3)~</div>
</div>

—n

<div class="productname">~name (4)~</div>

Execute MPFS2 Utility similar to step 4 and click Generate and Upload to program your new web pages.
. (IF USING THE SOLUTION WORKSPACE, skip to Step 16 to continue)

1 :; <div class="bar-in-ok"r~stock(2)~</div>
</div>
<div class="productname">~name(3)~</div>
<div class="bar-out" style="width: ~stock(3)~em">




Insert another callback function HTTPPrint_name ()into CustomHTTPApp. c. to display the name of the
requested product. This function accepts a single WORD parameter.

Product data is stored in the Product s array. Use the parameter as an index to this array, and print out the
associated name element using TCPPut St ring, as shown below.

rameter. Use the uitoa (WORD, BYTE*) function to convert the stock element from a binary value to a
string, then write the output to the socket.

@ Insert another callback function for HTTPPrint_stock (). This function also accepts a single WORD pa-

a CustomHTTPApp.c

1408 curHTTP.callbackPoa = 0x00;
TCPPutS5tring (sktHTTP, machineDes=c) ;

1410 K
void HITPPrint name (WORD item)

TCPPutS5tring (sktHTTP, Product=[item] .name) ;
1415 g

void HITPPrint stock (WORD item)
BYTE buf[4]:
uitoa (Products[item] .stock, buf) ;

TCPPutString (sktHTTE, buf) ;
1423

(Y'\! SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-

_l gy I_' TIONS. Build and Program the firmware into the selected device in RELEASE mode.

D% BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Verify that the bar graph display is now populated with dynamic data from the board. Vend a few drinks and

@ Access your board’s web page using a web browser.
click Refresh in your browser to verify that the stock numbers and bar lengths change.




Results A completed implementation will look similar to the following when

viewed in a web browser. As products are purchased from the machine, a refresh
of the browser page will indicate the new stock levels. An automatically updating dis-
play, while technically feasible, is outside the scope of this class.

Sample Completed Web Page

/3 Microchip WebVend Demo App - Microsoft Internct Explore

File Edit Miew Favorites Tools Help

D - =) (2] » | Address [&7 ntp:smchpboards

@ MicrocHIP WeBVEND DEMO APP

Status | Lights | Products

Machine MCHPBOARD :: Building C4 - 2nd Floor NW

Cola

L]
2

[ [ [ [ [Ndiccalmtranst

Code Analysis In the HTML file, two types of dynamic callbacks were in-

serted. In the first portion of the lab, standard text outputs were added. These callbacks
receive no parameters, and only needed to call TCPPutString () to write text into the web

page.

One of these callbacks (for the machine description string) may need to output more than 16 bytes. To prevent
potential buffer overruns, this callback had to manage its output state. Since the output was still relatively short,
the function just checks if enough space is available. If not, it returns after setting a flag in
curHTTP.callbackPos, which indicates to the server that this callback must be invoked again to complete its
output. This is an acceptable solution for strings less than about 50 bytes. For longer outputs, write as many bytes
as possible and use the callbackPos variable to track to position of the output, as discussed in the lecture
slides. Once complete, restore the cal lbackPos variable to zero to indicate that the callback is finished.
Dynamic variables for the names and stock levels of each product were also added. These variables had parame-
ters passed to the functions. All parameters are passed as WORD values, which the callback function uses as an
index to the Products array. The outputs of these functions were used for both printing text and controlling dis-

play elements, such as the length of the bars in the graph display.

()3 Conclusions

In this lab, web-based monitoring was been added to the vending machine. Several examples of dynamic variables
were implemented, demonstrating a wide range of capabilities for this flexible feature. With just a few lines of
code, the vending machine can now output its current status in a clean bar graph display.
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mBonus Procedure

Dynamic variables can also be used to control visual elements. Notice that one of the bottom two bars are red,
while the other bars are green. We’d like to control this color so that any products where stock is running low are
automatically highlighted in red.

Replace the text class attributes low and ok with a dynamic variable called ~status (1) ~ within the index.htm
file via Crimson Editor.

Execute MPFS2 Utility to bundle your changes to the webpage and upload them to the development board. The
utility will also update your copy of HTTPPrint . h to link in your new dynamic variables.

Insert a callback for HTTPPrint_status () in CustomHTTPApp.c. This callback function should print the
string “1ow” if stock is less than 8, and “ok” otherwise.

SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

e Verify after selective vending, the quantities and colors change appropriately.

HOSTHNAME™ and " _ _ _ Description™ with a dynamic wvarisbles "host
- ~machineDesc~ </diwv>

ach listing of "Product™ with a dynamic variable "name”™ an

sStatic instance guantity with a dynamic w idable "stock (i here i is O thru € -

. .—low™ sStatements with a2 the dynamid

=diw class="productname”>~name (0] ~</diwv>

“diwv class="bar—ocut”™ style="width: ~stock(0)~em">
class="kbar—in-~status (0) ~">wastock (0) ~< /diw>

<Sdiws

=diw class="productname”>-name (1) ~<./ diw>
ess="bar—out™ sStyle="width: ~stock(l)~em">
class="bar—in-~status (1) ~">~stock (1) ~</diw>

<diwv class="productname'™>-~name (2 ) </ diwv>

<=diw class="bar—ocut”™ style="width: ~stock(Z]~em">
<diwv class="bar—in—~status(Z) ~">~stock (Z) ~</diw>

< /sdiws

<diwv class="productname"™>~name (3) ~<,/diwv>



CustomHTTPApp.c

wold HITPFPrint status (WORD item)
1426 B

if (Products[item] .stock < 8)

TCPPutROMString (skcHTTP, (ROM BYTE+*) "low™) ;
else

ITCPPutROMString (sktHITFP, (ROM BYITE*) "ok™) :
1431

1433 Eddlahiks

Sample Web Page after Bonus Procedure

icrochip WebVend Demo App - Windows Internet Explorer

@Tﬁyv |-e; mehpboardind=s. him

| File Edit view Favorites Todls Help

J . Favorites J L= s AXIOM -Home @ | Microsoft Office Live Meetin... @ | sats Login

€8 Microchip WebVend Demo App ‘ |

A2\ MicrocHip COM4201 Demo ArpP

=

Status | Lights | Products

MCHPBOARD :: Building C4 - 2nd Floor NW

Cola
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Lab Exercise 6

Web-based Control via the GET Method

ﬁ
Purpose

Now that the vending machine can be monitored remotely, it would be nice to add some control features. As dis-
cussed, this can be accomplished through two different HTTP methods: GET and POST.
In this lab, you will learn how to use the GET method to pass short amounts of data to the device. In the process, an inter-
face for controlling the lights on the vending machine will be added. Since the current development platform only has
LEDs, one of these will be used for simulation. Control via the POST method will be discussed in a future class.

Requirements

Environment: MPLAB® IDE 8.60, X, or later, MPFS Utility, Masters 1538 Installer 1.536

C Compiler: MPLAB C18 v3.38 or later, C30 v3.30 or later, or C32 v1.12 or later

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO0 or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ , or MPLAB ICD 3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\Lab6...

Objectives

® Study the procedural steps associated with adding HTML forms to a web page to implement control
® Practice with including the necessary Callback code within an application to issue HTML Get based control.

r Web Page Directory:
’ C:\Masters\1538\Lab6\WebPages2

m Procedures

Open lights.htm, from the folder listed above with the Crimson Editor.
This file contains the HTML form that will be used to CONTROL the LEDs.
Start » Programs P Crimson Editor » Crimson Editor

Find the <form> tag, and notice that the method attribute is set to get. The form contains two input buttons,
e both of which are named lights.
Find the radio button inputs. Notice that both are named 1ights. When the form is submitted, the value of the
lights parameter will be set equal to whichever radio button is selected.

6-1



lights.htm

iR ! —— These two fields create the On/0ff radio selectors —-->
il <input type="radio" name="lights=" walue="1" /> On
il input type="radio" name="lights" walue="0" /> Off

Execute MPFS2 Utility similar to Lab5 step 4 and click Generate and Upload to program your new web

pages.
(IF USING THE SOLUTION WORKSPACE, skip to Step 8 to continue)

MPLAB File » Open Project

Lab6-C18-PICDN2-ETH97.X for the PICDEM.net 2 with internal MAC/PHY setup
Lab6-C18-PICDN2-MRF24WB.X for the PICDEM.net 2 with Wireless MAC/PHY setup
Lab6-C30-EXP16-ENC28.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10Mbps module
Lab6-C30-EXP16—-ENC624.X for the Explorer 16 with PIC24F/dsPIC33F PIMs with 10/100Mbps module
Lab6-C30-EXP16-MRF24WB . Xfor the Explorer 16 with PIC24F/dsPIC33F PIMs with WIFI module
Lab6-C32-EXP16-ENC28.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10Mbps module
Lab6-C32-EXP16-ENC624.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with 10/100Mbps module
Lab6-C32-EXP16-MRF24WB.X for the Explorer 16 with PIC32MX3xx/4xx PIMs with WIFI module

HTTPExecuteGet (). Find this function.

Note: The first step in this function is to determine which file name is being accessed (and therefore which form
has been submitted). The call to MPFSGetFilename () handles this, and then a memcmp variant is used to
check the filename.

e Open CustomHTTPApp . ¢ within MPLAB’s project window. Forms submitted via GET are processed in

memcmppgm2ram () compares an array in RAM to an array in program memory. |t
accepts the two pointers and a length parameter. If the two arrays match, it returns
zero, which is why the comparison is inverted.

Update the first comparison to check for 1ights.htm. Remember to update the length parameter to 10 as well.
If the name matches, the application should now look for a parameter called “1ights”. If the pointer returned
by the call to HTTPGetROMArg () is not NULL and matches ASCII ‘1, the pin LED4_ IO should be turned on.
Otherwise, the pin should be set to off.

Parameters returned from web forms are always represented as strings. If you re-
turn numeric values, they must be parsed from their string representations.




Insert the form processing functionality as shown on the following page. Remove any remaining code in
HTTPExecuteGet (), which will include the processors for cookies.htmand leds.cgi.

These forms were implemented in the demo application, but no longer exist in your project’s web pages. Ensure
that the function still returns HTTP_TO_DONE. This indicates to the HTTP2 server that the function is complete and
should not be called again.

N\
@ CustomHTTPApp.c
EIEIEY & & om R R R R R R e R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R
B HTTE 10 RESULT HITPExecuteGet (void)
lga
187 BYTE *ptr;
188 BYTE filename [20]:
189
190 f/ Load the file name
151 '/ Make sure BYTE filename[] abowve i= large enough for your longest name
1892 MPF5GetFilename (curHTTP.file, filename, 20):
193
194 / If it= the forms.htm page
155 if({'memcmppgmZram(filename, "lights.htm"™, 10))
19a {
197 / Seek out each of the four LED string=s, and if it exists =set the LED =states
158 ptr = HITPGetROMArg (curHTTP.data, (ROM BYTE #*)"light=s");
1599 if (ptr)
200 LED4_TI0 = (*ptr == '1'};:
201
202 ¥
return HTTP IQ DONE:
J

SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

D@ BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

| — )
BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Access your board’s web page and click on the link for Lights.
Verify that one of the LEDs on the board can be controlled using the web form.

Results

(1O

A correct implementation will allow you to control the state of one LEDs using a web form.

Code Analysis

As mentioned earlier, data received via the GET method is stored in curHTTP . data. This data is located using
HTTPGetROMArg (), which returns a pointer to the value, or NULL when the requested parameter was not
found. This pointer is then compared against expected values to determine the appropriate action.




Since HTTPExecuteGet () handles all GET forms, the function must resolve the form that was submitted by
checking the file name. The MPFSGetFilename () function determines the name of the file being accessed by
the server and stores it back to the temporary string for comparison.

Bonus Procedure

Most web forms pre-select the current value to provide a more intuitive interface to the user. This can be accom-
plished for your form using dynamic variables.

Open 1lights.htmin Crimson Editor again. You will add a dynamic variable here to pre-select the correct
radio button depending on whether the LED is on or off. A radio button will be selected if it has a checked at-
tribute.

Insert a dynamic variable in each radio button, which will allow your application to dynamically insert this attrib-
ute.
Save your changes to the HTML code

Execute MPFS2 Utility similar to step 3 and click Generate and Upload to program your new web pages.
(IF USING THE SOLUTION WORKSPACE, skip to Step 15 to continue)

O 6 6 B

il ! —— These two fields create the On/0ff radioc selectors —->
a:il<input type="radio" name="lights" wvalue="1" ~light chk{l)~ /> On
pi-l<input type="radio" name="lights" wvalue="0" ~light chk(0)~ /> OLL

Insert the callback function HTTPPrint_light_chk () via MPLAB into the file CustomHTTPApp.c. This
function will accept a single WORD parameter.

CustomHTTPApp.c

wvoid HITPPrint light chk (WORD state)

if(state == LED4_TIO)
TCPPutROMString (sktHITPE, (RCHM BYTE*®) "checked"™):

1381 E2Swlehia
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14 Inside this function, Insert a check if the parameter received matches the current state of LED4_T0O. If it does, use
TCPPutROMString () to write the string “checked” to the page.

SEE THE SECTION 2.1 OR 2.3 OF APPENDIX A FOR MPLABX BUILD AND/OR RUN OP-
TIONS. Build and Program the firmware into the selected device in RELEASE mode.

[
u@ BUILD TO CONFIRM NO SYNTAX ERRORS

SEE SECTION 1.8 IN APPENDIX A FOR CONFIGURING YOUR PROGRAMMER

E

[> BUILD, PROGRAM AND RUN IN THE TARGET SYSTEM

Verify that the current state of the LED is now pre-selected on your form when the page loads.

Bonus Procedure Results:

(1 ©

In this section, a dynamic variable was added to the radio buttons. This dynamic variable either prints “checked”
or nothing, depending on the state of the LED. By printing “checked”, the server can control the default state of

Pre-Selected Radio Button

K‘ Microchip WebVend Demo App - Windows Internet Explorer ]

@ ._"? |g http://mchpboard flights. htm?lights=0 L! Y4 A IY! ahoo! Search

| File Edit View Favorites Tools Help

J . Favorites ‘ = 4 AXIOM -Home & | Microsaft Office Live Meetin... & | sats Login ‘ }':i\ i v =] () - Page - Safety - Tools - '0'" Eﬁ B @
L~ | EE = o =

{& Microchip WebVend Demo App ‘ ‘

. E|
A8\ Microckip COM4201 Demo App

Status | Lights | Products

MCHPBOARD :: Building C4 - 2nd Floor NW

Control Lights

Lightss  on @ off
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Appendix A

MPLAB® X IDE Quick Reference Guide

Table of Contents
1. Managing Projects

1.1 HOW 1O OPEN @ PrOJECT..iiiciiris ceeeieeiieeieeeeeeesesseeeeseeseeeseeeeeseseessessssssassssssssssssssssssssssssssnsssnsasesnsnsnnens A-3
1.2 How to add existing files t0 @ PrOJECT ....ccccuiii it et aeee e A-4
1.3 How to create New files in @ ProjeCt.....c..eeeiiiiii it e e A-5
1.4 How to remove a file from @ ProjeCt......cuiiiiiii i e e A-7
1.5 How to permanently delete a file ... e A-7
1.6 HOW 10 SAVE @ fil@ OF PrOJECT . eiiiiiiieeeiie ettt e s e e er e e st eeesnta e e e entaeesneeeeens A-7
A o o1V VS o Mol [ L= I o] e [T ot f PSP A-8
1.8 How to modify project settings (choose debug tool, build tool, etc.) ..........cccoeeeevveeeccveeeirennnn. A-8
2. Building Projects
HOW t0 BUIIA @ PrOJECE nvviiiiiiiiieieet ettt sttt st e e bt e sabeesateesabeenaeas A-9
How to build and run a project With @ debUBEEN .......cooviiiiiiiii e A-9
How to build and run a project without @ debUEEET ........cooriiiiiiiiiei e A-10
3. Debugging Projects
How to set or change the dEDUEEEN ......ooi i e e e e e rar e e s A-11
How to control program execution when debugging........ccceoeeiiiiiiiiiiccceee e, A-12
How to set and clear breakpoints........uueiiiee it e e s e e e st e e e e neeeesnreeeeas A-12
HOW 10 USE the STOPWATCN ....ceiiiiii e e et e et e e e st a e e e enteeeenreeeeas A-13
How to display and USE@ WatCheS........ueeiiiiiieciiie ettt et ete e et e e e s ta e e e e neeeesnreeeans A-14
How to view Embedded Memory (SFRs, RAM, Flash, EEPROM and Configuration bits).................. A-15
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Section 1.7

How to close a project

0 There are two methods you can use to close a project:
Method 1:
Right click on the top node of the project in the project tree (the chip icon)
and select Close from the popup menu (about 2/3 of the way down).
Method 2:
From the main menu, select File b Close Project (project name)
where project name is the name of the project you wish to close—there may
be multiple similar menu items if you have more than one project open in
the IDE.

Section 1.8

How to modify project settings

0 There are three ways to access a project’s settings:
Method 1:
Right click on the top node (chip icon) of a project in the project tree and
select Properties at the very bottom of the long popup menu.

Figure 1.8.1 _Eﬂojects a = i Files i Clagses
The top node of a project in the pro- =, Lab1
ject tree |¢ Header Files
|+}ﬁ Library Files
Method 2:
From the main menu select File b Project Properties (project name)
Method 3:
If the Project Environment window is open (bottom left corner by default),
you can click on the “wrench and bolt” icon in its left margin.
Figure 1.8.2 | Lab1 - Havigator | Lab1 - Project Envi.. 4 &2
Project Properties button in the Pro- Project Properties R " s Device
ject Environment window. @a ,@ PIC24F1128GA010
- 48l Checksum: 0x0
E -D;j‘ C_Dmpiler Toolchain

From here you can select a different device, debug tool or build tool and you
can modify any of their settings. When choosing a new tool, click the Apply
button to make it show up in the tree on the left side.

:- Project Properties - Labl

Categories: Configuration
- @ General

e Conf: [default] Family: Device: Supported Debug Header:

i @ RealICE AllFamiies v | | PIC24F1128GA010 v | [[]Ac162065/AC244022

= @ C30

L pic30-as Hardware Toal: Compiler Toolchain:

i | Hardware Toals . Compiler Toolchains

@0 1CD 3 1 s (=

00 PICKt2 i @ ASM30 (v3.23) [C:\Program File
- PICKt3 @ ASM30 (v3.24) [C:\Program File
@ ASM30 (v3) [C:\Program Files {3

i@ ASM30 (v3.25) [C:\Program File

| |« [ I | 3

@ pic30-gco
- @ pic304d

*Tip: double dick on serial number (SN) to use 3 friendly name (FM) instead.

Manage Configurations...

[ CK. H Cancel H Apply H Help




Section 2.1

How to build a project

There are several ways to build a project in MPLAB X depending on what you
intend to do with the results. This method is only used to see the results of a
build or to produce a release mode hex file.

There are two different types of build you can do:

Build:

This will build only the files in your project that have changed since the last
build or it will build everything if nothing has been built previously. It will
generally be faster to use this type of build, especially for larger projects.
Clean and Build:

This will remove any intermediate files generated by the previous build and
will build every file in your project regardless of whether or not it has
changed since the last build to ensure a full, clean build.

There are two ways to access these two build types:
From the Main Toolbar:

Make in MPLAB IDE 8

Build All in MPLAB IDE 8

Alternatively, you can right click on the top node of a project (chip icon) in
the project tree and select either Build or Clean and Build from the popup
menu.

Section 2.2
How to build and run a project
with a debugger

When you want to build a project for the purpose of programming a target
to run with a debugger like the MPLAB® ICD 3 or REAL ICE, this is the method
to use.

There are three ways to build and run your code through a debugger:
Method 1: Er

Click on the Debug Project button on the main toolbar >

Method 2:

Right click on the top node of the project (chip icon) in the project tree and
select Debug from the popup menu.

Method 3:

From the main menu, select Debug P Debug Project (project name)

This will perform the following tasks automatically:
a. Build (make) project in debug mode

b. Program target (unless using simulator)

c.  Run code on target

Appendix A

2. Building Projects

Q@ information

The Build and Clean and Build
functions are not intended for
use before Run Project, Debug
Project or Make and Program
Target. All three of those func-
tions automatically do a build
before performing further steps.
No harm will be done by using
Build or Clean and Build first, but
it will be a duplication of effort
and will waste time.

Qnformation

It is not necessary to do a Build or
Clean and Build before doing a
Debug Project because a build
will be done automatically.
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Q@ information

It is not necessary to do a Build or
Clean and Build before doing a
Run Project because a build will
be done automatically.

o

Section 2.3
How to build and run a project
without a debugger

When you want to build a project for the purpose of programming a target
to run without a debugger, this is the method to use.

There are three ways to build and run your code on a target:

Method 1: [>

Click on the Run Project button on the main toolbar

Method 2:

Right click on the top node of the project (chip icon) in the project tree and
select Run from the popup menu.

Method 3:

From the main menu, select Run P Run Project (project name)

This will perform the following tasks automatically:
a. Build (make) project in release mode

b. Program target

c. Run code on target
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Additional Exercise
Creating a Simple Web

2 Purpose

Modern web pages are created using a combination of HTML and CSS code. HTML is a markup language, meaning that
the content is divided into a structure, with each element given a specific type. CSS is a style language which specifies how
to present the content found in the HTML structure. Together, these files are parsed by a web browser to create the on-
screen display.

In this lab, you will create a simple web page with your name, a brief paragraph about yourself, and a few visual elements.
You will test your page using the web browser on your PC.

Web pages for Microchip’s embedded platforms are compiled into an Microchip File System (MPFS) image. This image is
similar to a zip file, and includes all of your web page code in a format that is easy for the PIC to serve. To finish the lab,
you will bundle and upload your web page to your development board using the MPFS2 Utility, which will allow other
attendees to view the page on their PC.

If you finish early, a bonus section will teach some basic CSS to help you format your page.

Requirements

Software: MPEFS utility from Masters 1538 Installer v1.536, Crimson Editor

Environment: MPLAB® IDE 8.60 ,X, or later, Masters 1538 Installer 1.536

C Compiler: Not Required for this Lab

H/W Tools: PIC18F: PICDEM.net™ 2, or
PIC24FFJ128GA010 PIM: Explorer 16 w/ 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WBO or
PIC32MX360 or PIC32MX460 PIM: Explorer 16 & 10Mbps, 10/100Mbps PICtail™ Plus or MRF24WB0
AND MPLAB Real ICE™ , or MPLAB ICD 3
AND DHCP Enabled Router (wired or wireless)

Lab Files: C:\Masters\1538\AddILab\...

Objectives

® Practice HTML and CSS style sheet programming
e Utilize the MPFS utility to package web page information and transfer to dev tools via TCP/IP

[ Web Page Directory: C:\Masters\1538\AddlLab\WebPages2 ]

m Procedures

0 Confirm all the files located in WebPages2 directory shown above are deleted These are shipped with the TCP/
IP Stack, but are not needed for this class. However the same folder location will be used for new pages.
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Launch the Crimson Editor to create a new file named index.htm and save it in the WebPages2 mentioned
previously. Start » Programs » Crimson Editor » Crimson Editor File » New
File » Save As P index.htm in the folder C:\Masters\1538\AddlLab\Webpages2\

The default extension for HTML code in Crimson Editor is *.html. The default file
name for the HTTP2 server is index.htm. Make sure your extension only has
three letters!

Insert the required <html>, <head>, and <body> structure tags as shown in the sample web page below. In-
clude the appropriate closing tags </html>, </head>, and </body> as well.

Sample HTML Page Structure

<html>
<head>
<title>My First Web Page</title>
</head>
<body>
<hl>My First Web Page</hl>
<p>Compared to assembly, HTML is <b>really</b> easy!</p>
</body>
</html>

Inside the <head> tag, insert a <title> tag enclosing your company name. Insert a <hl> tag inside the
<body> tag, enclosing your personal name. Be sure to include appropriate closing tags as well.

Below the <h1> tag, insert a <p> tag enclosing two brief sentences about yourself. This will appear as a
paragraph of text on your page.

Below the <p> tag, insert another <p> tag. List information from your business card such as your name, title,
address, and phone number. Insert a <br /> tagto add a line break after each element of data.

In HTML, a <title> tag in the <head> section displays in the browser’s title bar, but not on the page itself.
The <h1> tag will display as big bold text in your page. <p> tags are displayed with a blank line of space
between them.
The <br /> tag forces a line break without this extra line of space. The <br /> tagisa self-closing tag. It
does not enclose content, but merely indicates a visual display element. Other examples of self-closing tags
include image tags <img .. /> and form input fields <input .. />.

7 © 0 ©
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Insert a link to your company’s website (or a site of your choosing) as the last line in the “business card” informa-
tion. Use an <a> tag. Insert an href (hyper-text reference) parameter to the tag indicating the link’s destination.
Enclose the text you wish to display (underlined in blue) in between the <a> and </a> tags. It should look some-

thing like:

<a href=“http://www.microchip.com”>www.microchip.com</a>

This should be a fully qualified URL, including http://, because the link references an ex-
ternal server. For local links you would list only the relative path to the page, such as:

<a href="“page2.htm”>Next Page</a>

Save the file, then view your completed web page by opening it in your web browser.
Windows Desktop » My Computer » Navigate to WebPages2 P Double Click index.htm

As you view the web page in the step, you can return to steps 3 through 8 to make changes. After saving, use
the browser’s Refresh button to see the modifications.

m Note the size of the file as it is saved from Crimson Editor, less than 500 bytes. It is important to avoid using
editors that generate large files that become difficult to fit in embedded memory arrays.

Sample Web Page

3 Dr. Microchip - Microsoft Internet Explorer

Fle Edit View Favorites Tools Help
3-8 -9 2 e |-"-er€55| http: //mchpboard;

Dr. Microchip

1 am an expert with microcontrollers and Web-Based design. Next time your application calls for
Ethernet capabilities, remember to use a Microchip microcontroller and the Microchip TCP/IP
Stack!

Dr. Microchip
Agpplication Engineer
2355 W Chandler Bid.
Chandler, A7 85224
480-792-7200

www.microchip.com

-
€] Done | LT T T [ wy Computer /

m Your classroom may not have Internet access, so the link you added to your web page may not work properly.
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In the next few steps, you will use the MPFS2 Utility to bundle your web page and upload it to your develop-
ment board. Before beginning, ensure that your development board is still running by confirming the new IP
address on the LCD, and confirm the index.htm is saved.

Start » Programs » Microchip » 1538 » MPFS2

° Open the MPFS2 Utility, so on the next page of this manual.

m How Web Pages are Bundled

Web Pages | MPFS2
Utility

Your Embedded
Application

y

EEPROM

EEPROM?

I
I
I
Using yes :
I
I

ﬁ Source Directory:
C:\Masters\1538\AddILab\WebPages2\

m Confirm that Start With: Webpage Directory is selected and that the correct source directory shown above is
entered:

m Confirm that Qutput: BIN Image is selected.

Project Directory:
C:\Masters\1538\AddILab\

@ Confirm that the OUTPUT FILES project directory shown above is entered:

@ Confirm that Upload Image is selected. Then click the Settings button and make the following changes and con-
firmations:

e Click the Defaults button to restore the standard settings.
e Set the Device Address to the host name you chose in Lab 1.
e (Click OK to save your changes.
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MPFS2 Utility After Configuration

—
-

AT Microchip MPFS Generator
Source Setlings

Start With: @ Webpage Directory Pre-Built MPFS Image

Source Directory:

C:\Masters1538\Addl|Lab"WebPages2 Browse |
Processing Options

< Qutput: @ BIN Image C18/C32 Image =1 ASM3D Image

Processing: Advanced Settings

Output Fles
Project Directory-
C:\Masters'1538%AddLab

3
Image Name: |(MPFSimg2

Upload Settings
Upload Image To:

[¥] |http://admin@MCHPBOARD/ { === to modify ==3)

4.

Date JUNE.16 2011
| Generate and Upload | Version MPES 2.2

3 [Generator Idle]

m The next step may cause the Windows Firewall to prompt you about allowing the MPFS
Generator to access the network. Be sure to click Unblock if this occurs.

Click the Generate and Upload button. The MPFS2 Utility
will package your web page and upload it to the development board.

Verify that you can now access your new web page from your board using the same address as you used in Lab 1.
Ensure the ICD2 debugger is disconnected and Confirm the Router has assigned an IP Address.

Access your neighbor’s board using their host name in your browser’s address bar. Confirm that they can
also access your web page from their browser.
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Results

Sample Web Page

/Z} Dr. Microchip - Microsoft Internet Explorer

File Edit WVew Favorites Tools Help
2 - & - (¢ 2] - |a'-'.gdressl http:/jmchpboard/

Dr. Microchip

I am an expert with microcontrollers and Web-Based design. Next time vour application calls for
Ethernet capabilities, remember to use a Microchip microcontroller and the Microchip TCP/IP
Stack!

D Microchip
Application Engineer
2355 W Chandler Blvd.
Chandler, AZ 85224
480-792-7200

www.microchip.com

=
Z

|.ﬁ:| Done l_l_l_l_’_| _g My Computer

Bonus Procedure

Return to index . htm in Crimson Editor. Insert a link to the style sheet you will create within the <head>
section:

<link href="style.css" rel="stylesheet" type="text/css" />
Insert a class parameter to the opening <p> tag containing your business card information. (The closing tag

does not need modification.) The opening tag should now look like:
<p class="businesscard">

@ Save the newly modified index.htm,

File » Save

Create a new file named style.css and save it in the WebPages2 folder with your HTML page.
File » New File b Save As b style.css

Insert style sections to the file as shown in the code analysis section on the following page. Save your changes,
then repeat steps 14 and 15 to verify that your changes are visible.

Colors are represented as hex RGB triplets, and you may modify them as you like. Sections matching the name
of a tag apply to all tags of that type. Sections with a period separator followed by another name apply only to
tags with a class matching the second name.
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Bonus Results

Final Web Page

_ff Microchip Inc. - Windows Internet Explorer

——
e ) b Ijé C:\RTC\COM4201v1_03WMicrochip Solutions\3olution 2\WebPages2Yindex.htm

J File Edit View Favorites Tools Help

I,j' EE;J? & Microchip Inc. | I

Dr. Microchip

I am an expert with microcontrollers and Web-Based design. Next time your application calls for
Ethernet capabilities, remember to use a Microchip microcontroller and the Microchip TCP/IP
Stack!

Dr. Microchip
Application Engineer

[T [ T wy Computer

<head:>
<title>Dr. Microchip</titleX>
<link href="style.css" rel="stylesheet™ type="text/css" />
</ head>
<body>
<hl>Dr. Microchip</hl>
<p>»I am an expert with microcontrollers and Web-Based design. Hext

time vour application calls for Ethernet capabilities, remember
to use a Microchip microcontroller and the Microchip TCP/IP Stack!</p>
<p class="businesscard">
Dr. Microchip<br />
hpplication Engineer<br />
2355 W Chandler Elvd.<br />
Chandler, LZ B85224<br />
480-792-7200<br />
<a href="http://www.microchip.com">www.microchip.com</a></p>
</ body>

J

The HTML document follows the required structure with an <html> tag enclosing <head> and <body> tags. The
<title> tagis added to give the page a title in the browser’s title bar (as well as in search engines, bookmarks, and
other locations).
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Within the body section, a header is inserted, followed by two paragraphs. The second paragraph uses the line break tag to
force new lines. Each tag (except for self-closing tags) has an associated closing tag terminating each section. The
<link> tag will only exist in your HTML if you completed the bonus section, as will the c1ass attribute in the second
<p> tag. If you did finish this section, you will also have a style. css file that looks similar to the following:

r style.css

& Crimson Editor - [CGYCOM4201v1 10\ Instructor\InstallerSource\Lab2So
File Edit Search WView Document Project Tools Macros Window Help

= shyle.css

Dody
background: #f£fff8f8;
font—family: Verdana, Arial, =sans—serif:
color: #444444;

a { color: #ccOO0O: 3
Ehl { color: #ccO0QO0O7 3
colar: #TTTTTT:

text—-—align: centers
font—size: O0O.8em;

:()3 Conclusion

This lab has presented an extremely brief overview of HTML and CSS. These languages form the foundation for mod-
ern web page development. Before starting your own designs, you’ll want to read about the other capabilities of
HTML, including <form> tags, <img>, <div>, <span>, and in-line formatting with <b> and <i>.

HTML and CSS are well documented in recommendations posted by the World Wide Web Consortium at their web-
site, www.w3c.org. For those who prefer tutorials to dense technical specifications, a quick visit to your favorite search
engine will turn up hundreds of sites teaching the fundamentals of HTML design.

For the remainder of the class, you will only need to be able to read and understand the structure of a few HTML docu-
ments. The web pages used for this class will be provided, so you will not need to build them from scratch. This pur-
pose of this exercise is only to familiarize yourself with HTML and learn enough to read code later.
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